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What's new

These new features are available only in Build 16002 and are not available in License Server VPX. 

• Call home capabilit ies have been extended to detect Citrix Service Provider licenses and report product usage 
to Citrix. 

• Citrix Licensing Manager Notif icat ions - Enables administrators to view licensing related notif ications and 

alerts direct ly within the Citrix License Manager.   

These features are available in Builds 15004 and 16002.

Citrix Licensing Manager - Enables downloading and allocation of license f iles from the License Server on which the

Citrix Licensing Manager is installed. You can specify a date range for the historical usage and export it to a CSV f ile.  The

CSV f ile provides daily usage information including the number of licenses in overdraft.  

Not available in License Server VPX.
Simple License Service is replaced - The Citrix Licensing Manager replaces the Simple License Service web UI.

Partial allocation of  licenses - When using the Citrix Licensing Manager to download your licenses, you can specify

how many licenses to download for a product. Previously, the Simple License Service allowed only a complete download

of licenses for a product.

Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home support for License Server
VPX  - Voluntary data collection programs in which Citrix products gather anonymous or identif ied configuration,

performance, error, and usage data from your deployment and automatically send the data to Citrix. For more

information, see Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home.

License Administration Console defaults to Hyper Text Transfer Protocol Secure  - When the License

Administration Console installs, it defaults to https.  

Finding information for your version of  licensing

See the tables below for a list of license server versions and their associated documentation.

Important: Citrix does not provide hotfixes for license server components and does not support older license servers with
newer products. The latest versions of the license server often contain resolutions to issues appearing in earlier versions.
When you upgrade or install new Citrix products, upgrade the licensing components as well. New license servers are
backward compatible and will work with older products and license f iles; however, new products often require the newest
license server to check out licenses correctly. You can f ind the latest version from the Citrix Downloads site.

To find your license server version number

If  you are unsure if  your license server version is current, you can verify it by comparing your version with the number on the

Downloads site.

On a license server with the License Administration Console:

1. Start the License Administration Console from the programs menu: Citrix > Management Consoles > License

Administration Console.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-architecture.html#par_richtext_5
https://www.citrix.com/downloads/licensing.html
https://www.citrix.com/downloads/licensing.html
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2. Click Administration and select the System Information tab. See the release version in the information list.

On a license server without the License Administration Console:

1. Open the Registry Editor (Start > Run > regedit).

Note: Use Registry Editor to view the license server information only. Editing the Registry can cause serious problems

that may require you to reinstall your operating system.

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\LicenseServer\Install.

The version number appears in the Version key in the format: 11.12.1.0 build 14100.

On servers running Windows 2008 Server 64-bit the registry key is

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\LicenseServer\Install
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Known and fixed issues

Mar 13, 2017

This article contains:

Installation issues

Other known issues

Other known issues and considerations - License Server VPX Only

License file issues

Product-specific issues

Fixed issues

Installation issues

If  Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled (the default configuration for

Windows 2008), connections can fail. Connecting remotely to the console or checking out licenses works until failover

occurs in the cluster. Exception rules for CITRIX.exe and lmadmin.exe are created during installation of Licensing and

Simple License Service, but do not work after a cluster failover. To work around this issue, create exceptions for Licensing

components on the Exceptions tab of the Windows Firewall panel. Create an exception for each of the following ports:

Console Web Server port (default port is 8082); License Server Manager port (default port is 27000); Simple License

Service port (default port is 8083); and Vendor Daemon port (default port is 7279). This issue occurs with Windows Server

2008 (32-bit and 64-bit), Windows Server 2008 R2, and Windows Server 2012. For more information,

seehttp://support.microsoft.com/kb/2568645. [#232365]

During the installation, the Configuration page is presented. If  you choose not to configure the License Server, you can

configure it at a later time. You must restart the License Server installer or use the configuration tool. You can open the

tool from: C:\Program Files\Citrix\Licensing\LS\resource\Licensing.Configuration.Tool.exe. If  the License Server

Configuration tool fails for any reason, uninstall and reinstall the License Server.

During installation, localized characters in the installation path can cause the installation to fail. Accept the default

installation path or enter only ASCII alphabetic letter characters for the installation directory. [#229456] 

When configuring the product-side setting for the License Server name, do not use localhost. Though you can use

the host name, IP address, or FQDN instead, Citrix recommends you use the FQDN. [#165986]

When you have the Citrix License Server 11.11.1 and greater installed and then install XenDesktop 5.6, the 30-day free

trial license is the only license available to you. Workaround: Accept the trial license and complete the installation. Use

Desktop Studio to change the product edition and license model settings after the installation. [#0388512]

The installation might fail if  the User Account Control (UAC) is enabled when installing on a cluster. [#0484356,

#0486196]

Other known issues

When using Internet Explorer 9 or 10, the Citrix Licensing Manager page might be blank or  icons might not display. One

of these might be the reason:

Compatibility view mode is Off  - Turn on Compatibility View mode.

Browser scripts are disabled - Enable browser scripts.

Caching of  active documents is enabled - Navigate to Internet options -> Advanced -> Security and deselect Do

http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_anchortitle_a38c
http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_anchortitle_89cf
http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_anchortitle_164a
http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_anchortitle_3127
http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_anchortitle_910c
http://docs.citrix.com/en-us/licensing/11-13-1/lic-about-11-13/known-fixed-issues.html#par_richtext_5
http://support.microsoft.com/kb/2568645
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not save encrypted pages to disk.

Assigning a busy port to the vendor daemon or License Administration Console might result in the vendor daemon going

down or the Licensing Administration Console becoming inaccessible.

Windows - The vendor daemon goes down if  you update the vendor daemon port with a port that is already busy

followed by a service restart. Access the License Administration Console and update the vendor daemon port with a

valid free port followed by a restart to restore License Server.

VPX - This situation requires a support call.

Because Citrix License Server 11.13.1 turns on HTTPS by default, you cannot collect license consumption information

with Citrix Usage Collector on new installations of 11.13.1. 

Workaround: Install Citrix Usage Collector on a License Server and open HTTP and block in the firewall or enable HTTP

and leave the firewall open for remote Citrix Usage Collector.

The username is case sensitive in some localized languages. To log on to Citrix Licensing Manager, set thedomain-

name\username in UPPER CASE if  it contains non-ASCII characters. [#595621]

If  you upgrade an older, existing cluster to 11.12.1, the message, "The installation drive is not part of the selected cluster

group. Select the correct cluster group or add the drive to the selected group." displays. To successfully use the new

11.12.1 clustering features, you must uninstall any License Server older than 11.12.1. The older License Servers do not

conform to current Microsoft cluster guidelines.

When you try to start the License Administration Console or the Citrix Licensing Manager, a blank page might display if

the Internet Explorer Enhanced Security Configuration is enabled and the License Administration Console or the Citrix

Licensing Manager is not in the Trusted Sites. Workaround: Disable Internet Explorer Enhanced Security Configuration.

[#382429]

Older Desktop Studio releases (prior to XenDesktop 7 Studio) using this version of the License Server do not display

license usage information or manage the License Server using the Licensing Node. This version of the License Server is

fully compatible with XenDesktop and can serve licenses for any Citrix product deployment. If  you continue to use an

older Desktop Studio, use the License Administration Console that ships with the License Server to display license usage,

manage License Server users, and upload licenses. If  you are using a version of XenDesktop prior to the XenDesktop 7

and you upgrade from earlier versions of Citrix License Server for Windows to version 11.11.1 and 11.12.1, you might see

the following warning:

Warning: Installing this update removes the Licensing Configuration Service. As a result, all versions prior to this release of

Studio provide only limited licensing information.

On non-English platforms, when starting a License Service installation on a cluster node, the Cluster Group list on the

Configure screen might contain the system default Cluster Group. Select one of the non-default Cluster Groups and the

installation continues normally. [#0497524]

lmhostid returns blank when it is queried to return an IPv6 type of address. 

Other known issues and considerations - License Server VPX Only

Studio does not display license usage information or manage the License Server. Use the License Administration Console

that ships with the License Server to display license usage, manage License Server users, and upload licenses.

When configuring XenDesktop 7.0 - 7.13 or XenApp 7.5 - 7.13, use the PowerShell Set-Configsite cmdlet to point to

License Server VPX. If  doing a fresh install, install and configure XenDesktop and XenApp using its installer, and then use

PowerShell to reconfigure and point to License Server VPX.

Set-ConfigSite -LicenseServerName <DNS_name/IP_of_licence_server> -LicenseServerPort <port>

Clustered License Servers are not supported for VPX. You can use the High Availability (HA) feature on XenServer 5.6 and

later.
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Ports 1-1024 are reserved by the operating system. When configuring the VPX ports, use ports above 1024. By default,

VPX uses port 8082 for SSL, which is open in the f irewall. If  you choose a different port for SSL, reconfigure the f irewall

in the iptables.

Upgrades are not supported for License Server VPX.

The License Server VPX does not support Active Directory.

License file issues

Certain license types are not covered by Subscription Advantage and therefore appear in alerts in the Dashboard of the

License Administration Console indicating that the Subscription Advantage date is expired. You can ignore such alerts for

any license not covered by Subscription Advantage. This includes Evaluation licenses, Not for Resale licenses, Early

Release licenses and Technology Preview licenses. These types of licenses do not need Subscription Advantage and your

Citrix products do not stop working when the Subscription Advantage date is expired. You can verify the status of any

license for which you receive an alert by clicking the license on the Dashboard. The license information expands to show

the license type (such as Technology Preview), the license expiration date, and the Subscription Advantage date.

[#231847]

License Files with multiple lines referencing HOSTNAME= are ignored by the License Server. Licenses in these f iles cannot

be checked out. This issue is caused when you download licenses associated to different License Server hostnames into

the same license f ile. The License Administration Console displays the following error message: "...Error List

Returned...Unknown Host."

To resolve this issue, download again separate license files for each Citrix product tied to different License Server names.

After you replace evaluation license f iles on the License Server with new license f iles, the Citrix product might continue

to display the following license expiration message when users log on: "Warning: The following Citrix Product is using an

Evaluation license. This license will expire in..."

To resolve this issue:

1. Remove the old evaluation license f iles from the License Server. (See Delete license f iles in Citrix documentation.)

2. At the License Server, restart the Citrix Licensing service.

3. At the Citrix product server that needs license validation, point to a f ictional License Server and then point the

product back to the actual License Server. (See your product's documentation for information about changing these

settings.)

4. If  the problem persists, restart the product server (for example, XenDesktop Controller).

Product-specific issues

Citrix XenApp Management Pack

Details about the Citrix License Server are always blank on the Monitoring tab of the System Center Operations

Manager for Citrix Managed Servers. There is no workaround for this issue. [#192159]

Fixed issues

To install License Server using PowerShell Remoting or deploy with Group Policy Objects, set the environment

variable FORCE_NO_SERVICE=1 on the target system. [#507466]

If  you enable https port redirection in the License Administration Console, udadmin might not connect to the

License Server. [#543418]

Workaround:

http://docs.citrix.com/en-us/licensing.html
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1. Disable Redirect non-secure web access to secure web access.

2. Restart Citrix Licensing service, creating a f irewall rule to block incoming access to the HTTP Port the License

Administration Console uses.

3. Inform users to access the License Administration Console using the HTTPS port.

For Windows only - Citrix Licensing 11.12.1 for Windows might be vulnerable to the Padding Oracle On

Downgraded Legacy Encryption (POODLE) vulnerability. POODLE affects older standards of encryption - Secure

Socket Layer (SSL) version 3 but not the newer encryption method Transport Layer Security (TLS). The workaround

to mitigate a security issue is documented athttp://support.citrix.com/article/CTX200265. [#0512929]

For VPX only - When the vendor daemon CITRIX is down or stopped, a Critical Alert does not appear in the

notif ication panel. [#450894]

 

http://support.citrix.com/article/CTX200265
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PDF

Third party notices

Dec 28 , 2015

Citrix Licensing 11.13.1 might include third party software licensed under the terms defined in the following document:

FlexNet Publisher Documentation Supplement Third Party and Open Source
Software used in FlexNet Publisher 11.13.1

http://10.57.13.146/content/docs/en-us/licensing/11-13-1/lic-about-11-13/FNP-Licensing-11.13.1-ThirdPartyOpenSource.pdf
http://10.57.13.146/content/docs/en-us/licensing/11-13-1/lic-about-11-13/FNP-Licensing-11.13.1-ThirdPartyOpenSource.pdf
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System requirements for Citrix Licensing

Feb 17, 2016

Requirements for Licensing for Windows

Citrix Licensing is compatible with the same hardware required to support the compatible operating systems. No additional

hardware is required. 

Note: The license server does not support multi-homing (two network cards plugged into distinct networks).
The License Administration Console manages the license server on the computer on which it is installed. It cannot manage

remote license servers. The Citrix Licensing Manager can install licenses only on the license server where it is installed.

Operating Systems You can install the license server on servers running the following Microsoft operating systems.

Citrix recommends that you install the latest Microsoft Service Pack and updates.

Windows Server 2008 Family

Windows Server 2008 R2 Family

Windows Server 2012 Family

Windows Server 2012 R2 Family

Windows 7, 32-bit and 64-bit editions

Windows 8, 32-bit and 64-bit editions

Windows 8.1, 32-bit and 64-bit editions

Disk Space

Requirements

161 MB for the licensing components

2 GB for User/Device licensing

Microsoft .NET

Framework

Requirements

Microsoft .NET Framework 3.5 SP1 or greater is required.

Browsers These are the browsers tested by Citrix. Others browsers might work, but all functionality might

not be available.

Note: Citrix recommends you use the most recent versions of the listed browsers.

Internet Explorer Version 11

Microsoft Edge

Mozilla Firefox Version 32 and 39

Chrome Version 40

Safari Version 5.1

Requirements for installing License Server VPX

XenServer must provide adequate virtual computing resources to the License Server VPX as listed in this table.
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Memory 512 MB. Sufficient for up to 500 Citrix servers and approximately 50,000 licenses, but monitor available

memory during operation to determine if  you need to add more memory. For larger environments, Citrix

recommends allocating more memory.

XenServer

version

XenServer 6.1, 6.2 and XenServer 6.5.

Minimum

Storage

Requirement

8 GB on the default Storage Repository inside the XenServer pool.

Virtual CPU

(VCPU)

1 VCPU. For larger environments or those leveraging User/Device licensing, consider adding a second

VCPU.

Browsers These are the browsers tested by Citrix. Others browsers might work, but all functionality might not be

available.

Note: Citrix recommends you use the most recent versions of the listed browsers.

Edge

Internet Explorer Version 10 and 11

Internet Explorer Version 9 in compatibility mode

Mozilla Firefox Version 32 and 39

Chrome Version 40

Safari Version 5.1
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Technical overview

Jul 08 , 2016

Before you can use your Citrix product, you must install Citrix Licensing. Citrix Licensing is a system of components that

function together. This system includes:

License server - A system that allows licenses to be shared across the network.

License f iles - The f iles that you need to license your product. These f iles are stored on the License Server.

License Administration Console - The interface you use to manage your license f iles and your License Server.

Web Services for Licensing - Enables Studio, Director, and the Licensing Administration PowerShell Snap-in to

communicate with the License Server and manage users, allocate and install licenses, display License Server health, license

usage, and other alert messages. Not available with License Server VPX.
Citrix Licensing Manager - Enables allocation and installation of license f iles on a License Server using a GUI and enables

the creation and exporting of License Server historical usage reports. Not available with License Server VPX.
Product-side settings in your Citrix products that are associated with the License Server. 

 

Overview of  Citrix Licensing

Every Citrix product environment must have at least one shared or dedicated License Server. License servers are computers

that are either partly or completely dedicated to storing and managing licenses. Citrix products request licenses from a

License Server when users attempt to connect.

Servers running Citrix products contact the License Server to obtain licenses.
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When users connect to a Citrix product, it draws licenses from the License Server. That is, the Citrix product requests to

check out a license from the License Server on behalf  of the user or client device. When the license is successfully checked

out, the user can run the product.

Depending on the size and configuration of your product deployment, you may deploy licensing on a server shared with

other applications, a dedicated License Server, or multiple License Servers.

License files must be located on the License Server that is associated with the product you are licensing and the product

must be configured to communicate with that specific License Server. The License Administration Console lets you manage

and monitor your Citrix licenses by providing a user interface to the License Server. You can view a dashboard of licenses and

alerts, import license files, and manage License Server settings.

Licensing operations overview

Typically, the first time a user connects to a Citrix product, the product requests a license from the License Server. When the

License Server grants a license request, the Citrix product reserves a license for its use. Reserving licenses for this purpose is

known as checking out licenses. When the user logs off  from the product server, the product returns the license to the

License Server. This process is known as checking in licenses. With some Citrix products the license is checked out as soon as

a user connects to the product, and the license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the License Server by checking out the startup license. The

startup license is a Citrix system file that enables Citrix products to maintain a continuous connection to the License Server.

The following figure shows that each product forms its own constant connection to the License Server.

The Citrix product makes a continuous connection to the License Server. The License Server can support up to 10,000

continuous connections.

For example, when a server running XenDesktop requests a license, the product retrieves the License Server name and port

number information from the data store and establishes a connection to acquire the appropriate licenses.

There are three stages of the license checkout process.

A Citrix product goes through a three-step process to check out licenses:
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1. At startup, a computer running a Citrix product checks out a startup license.

2. A client device connects to the product server.

3. The product requests a license from the License Server.

Citrix products, such as XenDesktop, store a replica of the licensing information from the License Server, including the

number and type of licenses. If  a Citrix product server loses its connection to the License Server, or the License Server does

not respond in a timely manner, the product enters a grace period and uses its local record of the licenses to continue

licensing the product during the grace period. Citrix products update this record every hour.

Grace periods

If  product servers lose communication with the License Server, the users and the products are protected by a grace period

that allows the product servers to continue operations as if  they were still in communication with the License Server. After

a startup license is checked out by the Citrix product, the product and the License Server exchange "heartbeat" messages

every five minutes to indicate to each other that they are still up and running. If  the product and the License Server fail to

send or receive heartbeats, the product lapses into the licensing grace period and licenses itself  through cached

information.

The grace period is set by Citrix. It is typically 30 days but can vary depending upon the product. The Windows Event Log,

and other in-product messages, indicate if  the product has entered the grace period, the number of hours remaining in the

grace period. If  the grace period runs out, the product stops accepting connections. After communication is re-established

between the product and the License Server, the grace period is reset.

The grace period takes place only if  the product has successfully communicated with the License Server at least once.

Note: For products that operate in disconnected mode, the grace period takes effect after the preconfigured time
specif ied for the license check-out expires.
Grace period example - two sites, both using the same License Server

The connection between Site 1 and the License Server goes down causing Site 1 to go into the grace period, continuing

operation and making connections. For Concurrent licenses, they can connect up to the maximum concurrent licenses

installed. For User/Device licenses, they have unlimited connections. When Site 1 reestablishes communication with the

License Server, connections are reconciled and no new connections are allowed until they are within normal license limits.

Site2 is unaffected and operates as normal.

If  the License Server goes down, both sites go into the grace period. Each site allows up to the maximum number of

licenses installed. As above, the User/Device licenses have no limit.

Disconnected mode

Some Citrix products can operate in a disconnected mode (not connected to the server). These products allow a user to

check out a license and operate the product for a preconfigured period of time that is set by the administrator. In this case,

heartbeat messages are not exchanged. For products that operate in disconnected mode, the grace period takes effect

after the preconfigured time specified for the license check-out expires.

Supplemental grace period

For the supplemental grace period to be available, you must be using a minimum of  XenApp 7.6 and/or XenDesktop 7.6.

License Server VPX does not support supplemental grace periods.
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If  all licenses are in use, the supplemental grace period enables users to connect to a product for a limited period of time

allowing you to address the issue. The default supplemental grace period is 15 days. During this period there is no limit on

connections. After it expires, normal (to the extent of license availability) connection limits are enforced. Users are not

disconnected, but as they disconnect, no new connections occur until license levels return to normal.

Supplemental grace periods are granted per product and edition and per Subscription Advantage Eligibility date (per

product) and only for Retail licenses. For example, if  you have two clients requesting XenDesktop Enterprise Concurrent,

with different Subscription Advantage Eligibility dates, two supplemental grace periods are granted.

Rearming the supplemental grace period - When you take corrective action (for example, installing an additional Retail

license), the supplemental grace period is rearmed, and normal license limits are enforced again. If  you take action while the

supplemental grace period is in force, the License Server exits the supplemental grace period before rearming. When the

supplemental grace period is rearmed, you can trigger a new 15 day supplemental grace period the next time you go over

the license limit.

Citrix recommends that when the supplemental grace period starts, allow it to run rather than adding licenses immediately

to remove the warning condition. 

The supplemental grace period is enabled by default. To disable it, enter the following line in the options file:

#CITRIX SGPOFF

Note
The only way to disarm the supplemental grace period is by either adding more licenses or disabling the supplemental grace period

feature.

License server components

The License Server comprises several licensing components:

Citrix vendor daemon

License Administration Console

License f iles

Options f ile

Startup license

Web Services for Licensing

Citrix Licensing Manager

Figure 1. License Server Components. This diagram shows the Citrix product using TCP/IP to connect to License Server
components.
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Citrix vendor daemon
Licenses are granted by the Citrix vendor daemon (CITRIX), a process that runs on the License Server. The Citrix vendor

daemon tracks the number of licenses that are checked out and which product has them. Citrix products communicate

with the Citrix vendor daemon using TCP/IP. By default, the Citrix vendor daemon uses TCP/IP port 7279.

License files
License files are text files created by Citrix that store licensing data. They contain information about the product licenses

and the number of licenses, as well as system information such as the name of the License Server. The License Server uses

these files to determine whether to grant a license to a Citrix product.

Startup license
The startup license (citrix_startup.lic) allows Citrix products to communicate with the License Server using a continuous

open connection. The startup license:

Tracks which product servers are connected to the License Server

Stores licensing system information

Does not affect your license count

Caution: Do not edit the startup license file, or any other license files.

Citrix License Server Diagnostics License|Server
The License Server uses Citrix License Server Diagnostics License|Server for internal diagnostics and alert message

notifications displayed in Studio and Director. It is available by default with the startup license in the citrix_startup.lic file.

Options file
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The options file (Citrix.opt) is a License Server configuration file that the Citrix vendor daemon reads every time it restarts or

receives a command to reread the file. This configuration file defines licensing behavior— the number of licenses a product

server can use, the location of the system logs, and other user-defined customizations.

Web Services for Licensing
License Server VPX does not support Web Services for Licensing.

Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing to communicate with

the License Server and manage users, allocate and install licenses, display License Server health, license usage, and other

alert messages. The Citrix Licensing Manager also uses it.

Citrix Licensing Manager

The Citrix Licensing Manager enables the following features on a License Server using a simple GUI interface:

Allocation and installation of license f iles.

Creating and exporting historical usage reports from the License Server on which the tool is installed. You can specify a

date range for the historical usage data and export it to a CSV f ile.  The CSV f ile provides daily usage information

including the number of licenses in overdraft.

Important notif ications of license availability, expiration, and other conditions. Use the bell icon at the top of the Citrix

Licensing Manager screen to display notif ications.

The Citrix Licensing Manager is on by default.

Important
License Server VPX does not support the Citrix Licensing Manager.

The License request process

When a product requests a license from the License Server, the Citrix vendor daemon determines whether a license is

available for the request.

The license request process has two phases: the product startup phase and the user connection phase.

Product Start-Up Phase

When a Citrix product starts, it retrieves the License Server location from its data store

The product connects to the Citrix vendor daemon

The product checks out a startup license

User connection phase

A user connects to a computer running the Citrix product

The product requests a license from the License Server

The Citrix vendor daemon checks to see if  any licenses are available and grants or denies the product's request

The license module in the product grants or denies the use of the product based on the response from the Citrix vendor

daemon

Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home
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The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to
improve your product experience. After installing License Server 11.13.1, you can participate in the programs anonymously or
choose to be identif ied.
You can change your participation in the program at any time.

Note: Because the Citrix Service Provider program requires CEIP and Call Home, if  you have Citrix Service Provider licenses

installed, you cannot disable CEIP or Call Home.  

When installing licensing on the command line, you can use CEIPOPTIN to specify whether, or how, to opt-in to Citrix

Customer Experience Improvement Program (CEIP) or Call Home Optional parameter. The default is None.

Diagnostic - Call Home

Anonymous - CEIP

None

For more command line installation information, see the "Use the command line to install licensing" section under Install

licensing components for Windows.

You can modify the choice made at installation by editing the CITRIX.opt file:

#CITRIX CEIP value

where value is DIAG, ANON, or NONE

On VPX, do not modify the CITRIX.opt file. As root, execute the following command and make your choice of CEIP [1.DIAG

2.ANON 3.NONE]

# reset_ceip.sh

Citrix Licensing Customer Experience Improvement Program (CEIP)

CEIP is voluntary. When you opt-in, the CEIP services running in Citrix products gather anonymous configuration and usage

data from your deployment, and automatically sends the data to Citrix. CEIP collects these classes of data:

Configuration data

Performance and reliability data

How your privacy is protected:

Citrix does not collect any personally identif iable data.

Random identif ier is created at install time, which tracks data transfers over time.

Citrix does not record information such as IP addresses, server names, or domain names.

All data is sent using HTTPS directly to Citrix servers - no third party data hosting services.

All data is secured on Citrix servers and is accessible only by authorized individuals.

Citrix Call Home

Call Home is voluntary. When you opt-in, Call-home performs periodic collection of system and product configuration,

performance, errors, and more. The data identifies you as a customer. This information is transmitted to Citrix Insight

Services for Citrix support and product teams to resolve issues proactively.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_richtext_10
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Types of licenses

Mar 16, 2015

Your product uses one of the following types of licenses (some products allow you to choose more than one type). It is

important that you are aware of which types of licenses your company has purchased and how they are consumed. This

ensures that you do not run out of licenses. The license types are:

User/Device licenses

With XenDesktop 5 Service Pack 1 or later and XenApp 6.5 or later, the license server can assign licenses to a user or a

device and monitor license consumption. When assigned to a user, the license allows access from an unlimited number of

devices. When assigned to a device, the license allows access from the device by an unlimited number of users.

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of XenDesktop.

Use this type of license for shared devices, such as classroom or hospital.

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the

user to connect to their desktops and applications with multiple devices, such as desktop computer, laptop, netbook,

smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently.

When users or devices connect to an application or desktop, they consume a license for the 90 day license assignment

period. The assignment period begins when a connection is made, is renewed to the full 90 days during the life of the

connection, and expires (allowing reassignment) 90 days after the last connection terminates (logs off  or disconnects). If

you have to manually end a license assignment before the 90 day period elapses (for example, an employee consuming a

User license leaves the company), use the udadmin command line tool.

Optimization

Using the optimization process, the License Server determines how to minimize consumption based on users and

connections. The license server optimizes every 5 seconds until there are 5000 unique connections. At 5000 unique

connections optimization occurs every 5 minutes, which might delay status information until the next optimization

impacting when license usage statistics are updated in various consoles..

Examples of unique connections - Note that optimization is not consumption and these examples show when optimization

occurs.

Optimization occurs every 5 seconds for 1-4999 uses and every 5 minutes for 5000 or more uses.

700 users * 1 device each = 700 (optimize every 5 seconds)

5000 users * 1 device each = 5000 (optimize every 5 minutes)

5000 devices * 1 user each = 5000 (optimize every 5 minutes)

2500 users * 2 devices each = 5000 (optimize every 5 minutes)

Note: Optimization can be CPU intensive depending on the number of unique connections. Citrix recommends using
machines with multiple cores if  you have an extremely large deployment.
Concurrent licenses

This type of license is not tied to a specific user. When a user launches a product, the product requests the license and it is
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checked out to the specific computer or device that the user is using. When the user logs off  or disconnects from the

session, the license is checked back in and is available for another user. Using this logic, keep the following scenarios in mind:

Multiple sessions at different computers use multiple licenses. Each time a user launches a Citrix session from a different

computer or device, a license is checked out until the user closes the session at that computer or device (at which point

the license is checked back in). For example, if  a user launches a session from one computer and then launches another

from another computer (before closing the session on the f irst), two licenses are checked out.

Because, license servers do not communicate with each other, if  you are running multiple license servers you may

consume more than one license (for example, with load balancing). If  you are using load balancing, Citrix recommends

that the product servers point to the same license server.

Different editions consume different licenses. If  a user connects to an application published on a computer running

Advanced edition and then uses the same client to connect to an application published on a computer running Enterprise

edition, two licenses are consumed.

Only one license is consumed when a user makes multiple connections from a single device to different product servers

configured as the same edition and pointing to the same license server.

When a user connects from a single device to two product servers that are the same edition but different versions, one

or two licenses might be consumed based on the order in which the user makes the connections. For example, the two

servers are XenApp 6.0 and XenApp 6.5 (though this applies to nearly all Citrix products and versions):

The user connects to XenApp 6.0 f irst - Two licenses might be consumed - An older license f irst and then a newer

license.

The user connects to XenApp 6.5 f irst - Only one license is consumed.

RDP connections consume a license (RDP connections to a console do not consume a license).

Per user licenses (Only user licenses - not the same as User/Device licenses)

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the

user to connect to their desktops and applications with multiple devices, such as desktop computer, laptop, netbook,

smartphone, or thin client. A licensed user can connect to multiple instances of a product concurrently. When users connect

to an application or desktop, they consume a license for the 90 day license assignment period. The assignment period

begins when a connection is made, is renewed to the full 90 days during the life of the connection, and expires (allowing

reassignment) 90 days after the last connection terminates (logs off  or disconnects). If  you have to manually end a license

assignment before the 90 day period elapses (for example, an employee consuming a User license leaves the company), use

the udadmin command line tool.

Per device licenses (Only device licenses - not the same as User/Device licenses)

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of a product.

Use this type of license for shared devices, such as classroom or hospital. It allows an unlimited number of users per device.

When devices connect to an application or desktop, they consume a license for the 90 day license assignment period. The

assignment period begins when a connection is made, is renewed to the full 90 days during the life of the connection, and

expires (allowing reassignment) 90 days after the last connection terminates (logs off  or disconnects). If  you have to

manually end a license assignment before the 90 day period elapses (for example, an employee consuming a User license

leaves the company), use the udadmin command line tool.

Per socket licenses

Licenses are consumed per CPU socket actually used by a CPU and cores are not counted. For example, if  a computer with

two CPU sockets has only one CPU, only one license is used. In another example, if  that same computer with two sockets

has two CPUs, each with a quad core, only two licenses are used.
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Named user licenses

When a product requests a license, it is checked out to the user until a preconfigured period of time expires. This type of

check-out is not tied to a computer or device; once the license is checked out, the user can run multiple sessions on

different computers without checking out more licenses.
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Get started

Aug 10 , 2016

This article contains the following information:

Ensure you have the latest license server

Security considerations

Firewall considerations

Install licensing components for Windows

Obtain your license files

Disable domain name truncation on Windows

Disable domain name truncation on the Citrix License Server VPX

Move license files from an older License Server VPX version

Citrix recommends that you upgrade the license server to the latest version when you upgrade or install new Citrix products.

New license servers are backward compatible and work with older products and license files. New products often require

the newest license server to check out licenses correctly.

Licensing your product includes the following steps:

1. Ensure you have the latest license server version.

2. Verify system requirements.

3. Install licensing.

4. Obtain license f iles from My Account or if  you have a license code, use Citrix Licensing Manager.

5. Install your Citrix product (or, if  already installed, restart the Citrix products for the new licenses to be recognized)

6. Configure product-side licensing communication settings that were not set during product installation, if  applicable. This

includes setting the correct product-edition in the product. Details about these settings are covered in the product

documentation.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For example, if  you

purchased Platinum edition licenses, ensure that the edition setting in the product indicates Platinum-not Enterprise or

Advanced.

Important
The License Server does not require domain membership.  You can install the License Server in a workgroup and still perform all

licensing functions on behalf of Citrix products. To manage the License Administration Console or the Citrix Licensing Manager users

with Active Directory users or groups, the users must be part of a domain; otherwise, use local Windows users.

See Technical overview for an overview of the licensing components and process.

Ensure you have the latest license server

http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_richtext_2
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_richtext_6
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_richtext_8
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_richtext_10
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_anchortitle_187f
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_anchortitle_846e
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_anchortitle_662b
http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_anchortitle_fe32
http://docs.citrix.com/en-us/licensing/11-13-1/lic-architecture.html
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When upgrading or installing new Citrix products, always have the latest license server. The new license server is

backward compatible and will work with older products and license files; however, new products require the newest license

server to check out licenses correctly. You can install or upgrade the latest version from the product media.

Note: Citrix does not provide hotfixes for license server components and does not support older license servers with newer
products. The latest versions of the license server often contain resolutions to issues appearing in earlier versions.

To find your license server version number

If  you are unsure if  your license server version is current, you can verify it by comparing your version with the number on the

Downloads site.

On a license server with the License Administration Console:

1. For windows: Start the License Administration Console from the programs menu: Citrix > License Administration

Console.

For License Server VPX and remote systems: Open a web browser and go to https://License Server

Name:secureWebPort.

2. Click Administration and select the System Information tab. See the release version in the information list.

Security considerations

Citrix recommends that you upgrade the license server to the latest version when you upgrade or install new Citrix products.

New license servers are backward compatible and work with older products and license files. Each time a new license server

is released, it may contain better security features than in previous versions.

Citrix also recommends the following security considerations when you configure your environment or use the Licensing

Administration Console.

Configure the license server environment so that only authorized administrators on a trusted network are permitted to

access the Licensing Administration Console port. You achieve this with an appropriately configured network or host-

based f irewall.

When using the Licensing Administration Console, avoid visiting untrusted websites or clicking on untrusted URLs.

Firewall considerations

Determine if  you need to place a firewall between the license server and any product servers. Citrix recommends that you

determine if  your products will communicate with the license server through a firewall before installing licensing. Where you

install the license server can be impacted by firewall considerations.

The License Server VPX has default ports enabled. To change ports, use the Linux iptables command.

If  you have hardware firewalls in your environment, you must manually create the necessary rules.

If  there is a f irewall between your product and the license server, you need to configure port numbers. This configuration
process entails:

Determining which port numbers you need to change. You can change port numbers during the installation process or

afterward.

Opening up the f irewall ports. Open any ports on the f irewall that you modif ied so that traff ic can f low. For Windows

Server 2008, the license server Version 11.5 or later configures the built-in f irewall automatically.

Modifying the product-side settings. Your Citrix product must be configured with the same port numbers as those in the

http://www.citrix.com/English/SS/downloads/downloads.asp?dID=36239
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License Administration Console. If  you do not change the port number referenced in the product, the product cannot

contact the license server. You can change the product-side settings during and after installation of the product. See

your product's documentation for information about these settings.

Install licensing components for Windows

Licensing components can either be installed on a separate, dedicated server or on a server they share with another

application. Alternatively, you can use a Web or application server; however, the locations mentioned below are less

resource intensive. If  you are running fewer than 50 servers or 10,000 licenses, you can install the License Server on the

same server as your product. You can monitor CPU and Memory load (lmadmin.exe and CITRIX.exe) to determine if  you

should relocate the License Server to another system.

Important
Use the new CitrixLicensing.exe file for all installations going forward, except for Active Directory deployments. In that case, use the

.msi.

Ensure that both .exe and .msi files are present for the installation.

Install the License Server and console using the graphical interface

If  you install the License Server without successfully configuring it during or after installation, any subsequent License Server

upgrades fail.

1. Download the License Server from citrix.com and start the License Server installer, CitrixLicensing.exe, as an administrator

or a member of the Administrators group.

2. Follow the installer graphical interface to accept the destination folder.

Licensing components are installed in C:\Program Files\Citrix\Licensing on a 32-bit computer andC:\Program Files

(x86)\Citrix\Licensing on a 64-bit computer.

3. On the Configure page, accept or change the default port numbers for use by licensing components and choose

whether to allow the installer to configure the Windows Firewall exception. You can change the port numbers after

the installation, if  needed. If  you choose to f inish the installation without configuring the License Server, restart the

CitrixLicensing.exe installer or use the License Server Configuration tool to configure the settings after the installation.

You can open the configuration tool from: C:\Program

Files\Citrix\Licensing\LS\resource\Licensing.Configuration.Tool.exe.

License server port number is 27000

Vendor daemon port number is 7279

Management Console Web port is 8082

Web Services for Licensing port is 8083

4. The License Server adds the default License Administration Console administrator based on how you are logged on. If

you are in a domain, the License Server adds the installing user (domain\user) as a default License Administration Console

administrator. If  you are a local Windows user, the License Server adds the installing user (computer\user) as a default

License Administration Console administrator. The BUILTIN\administrator group, which allows any administrator to

manage licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing to specif ied users. Any

user that has access to managing the License Administration Console can also manage the Citrix Licensing Manager.

5. Choose to launch the License Administration Console or the Citrix Licensing Manager and whether to join the Citrix

http://citrix.com/
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Customer Experience Improvement Program.

If  you do not choose the Citrix Licensing Manager, or a license from you product's administration console, you are now

ready to go to the Citrix Web site to obtain the license files needed to run your Citrix products. This procedure is detailed in

"Obtain your license files" below.

Use the command line to install licensing

When using the CitrixLicensing.exe command to install licensing, set properties by adding Property=value on the command

line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges,

choose Start , right-click Command Prompt , and choose Run as administrator.

Note: Because the Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call

Home, if  you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

The following sample command line installs licensing in silent mode. Add the properties you want to set.

Type the command in one line without returns. The following example shows multiple lines due to space limitations.

CitrixLicensing.exe /quiet /l install.log INSTALLDIR=installdirectory WSLPORT=portnumber
LSPORT=portnumber VDPORT=portnumber MCPORT=portnumber CEIPOPTIN=value

where:

/quiet specif ies a silent (quiet) installation.

/l specif ies the log f ile location

INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program

files\citrix licensing or c:\program files (x86)\citrix\licensing.

WSLPORT is the port number used for the Web Services for Licensing. Optional parameter. The default is 8083.

LSPORT is the port number used for the License Server. Optional parameter. The default is 27000.

VDPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.

MCPORT is the port number used for the console. Optional parameter. The default is 8082.

CEIPOPTIN specif ies whether, or how, to opt-in to Citrix Customer Experience Improvement Program (CEIP) or Call

Home. Optional parameter. The default is None.

Diagnostic - Call Home

Anonymous - CEIP

None

You can modify the choice made at installation by editing the CITRIX.opt file:

#CITRIX CEIP value

where value is DIAG, ANON, or NONE

On VPX, do not modify the CITRIX.opt file. As root, execute the following command and make your choice of CEIP [1.DIAG

2.ANON 3.NONE]

# reset_ceip.sh
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Using the command line to install licensing for an Active Directory deployment

When using the Msiexec command to install licensing, set properties by adding Property="value" on the command line

anywhere except between an option and its argument. Clustering is not supported in the .msi.

Note: Ensure that you run the command line with administrator privileges. To start the command prompt with elevated

privileges, choose Start , right-click Command Prompt , and choose Run as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture information about this

operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example shows multiple lines due to space limitations.

msiexec /I ctx_licensing.msi /l*v install.log /qn INSTALLDIR=installdirectory LICSERVERPORT=portnumber
VENDORDAEMONPORT=portnumber MNGMTCONSOLEWEBPORT=portnumber
WEBSERVICELICENSINGPORT=portnumber CEIPOPTIN=value

where:

/l*v is the location of the setup log. Optional parameter.

/qn specif ies a silent (quiet) installation.

INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program

files\citrix licensing or c:\program files (x86)\citrix\licensing.

LICSERVERPORT is the port number used for the License Server. Optional parameter. The default is 27000.

VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.

MNGMTCONSOLEWEBPORT is the port number used for the console. Optional parameter. The default is 8082.

WEBSERVICELICENSINGPORT is the port number used for the Citrix Licensing Manager. Optional parameter. The

default is 8083.

CEIPOPTIN specif ies whether, or how, to opt-in to Citrix Customer Experience Improvement Program (CEIP) or Call

Home. Optional parameter. The default is None.

Diagnostic - Call Home

Anonymous - CEIP

None

You can modify the choice made at installation by editing the CITRIX.opt file:

#CITRIX CEIP value

where value is DIAG, ANON, or NONE

Obtain your license files

After you install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

Studio in XenApp and XenDesktop. For more information, see License in the XenApp and XenDesktop documentation in

eDocs.

Citrix Licensing Manager.

License Administration Console.

citrix.com.

http://docs.citrix.com/en-us/xenapp-and-xendesktop/7-7/manage-deployment/licensing.html
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Before going to the Citrix web site, you need the following information at hand:

The license code. Find this code: on the Citrix installation media pack, in an email you receive from Citrix, or from the

Subscription Advantage Management-Renewal-Information system (SAMRI).

Your user ID and password for My Account. You can register for this password on My Account.

Note: If  you cannot locate these items, contact Citrix Customer Service.

The name of  the server on which you installed the licensing components. The entry f ield for this name is case-

sensitive, so ensure that you copy the name exactly as it appears on the computer.

You can find the license server host name and MAC address (Ethernet) in the License Administration Console in the

Administration area on the System Information tab. You can also run the hostnamecommand at a command prompt on

the license server.

How many licenses you want to include in the license f ile. You do not have to download all of the licenses you are

entitled to at once. For example, if  your company purchases 100 licenses, you can choose to allocate and download only

50 at this time. At a later date, you can allocate the rest in another license f ile. You can have more than one license f ile.

Obtain licenses with the Citrix Licensing Manager

Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download

licenses:

Once you click Allocate and Download, you cannot cancel it. If  the Allocate and Download fails, use My Account at

citrix.com.

The Citrix Licensing Manager allocates only retail licenses (no evaluation or demo licenses or Subscription Advantage

renewals) and does not support redownloading or reallocating of license f iles. For those features, use My Account.

If  you rename the license server, you must reallocate any license f iles allocated under the old license server name. For

more information about reallocating f iles, see Reallocate license f iles.

1. In the Start menu, click All Programs > Citrix > Citrix Licensing Manager or from a remote machine,

https://licenseservername:8083.

2. If  you want to change the port and/or language, click the Settings icon on the menu bar at the top of the page. Make

changes and click Save.

3. Click Allocate Licenses, type the License Access Code (which is supplied in an email from Citrix) and click Display
Licenses.

4. Select a product from the displayed list and click Allocate and Download. To select more than one product, choose a

product, click Allocate and Download, choose the next product, click Allocate and Download, and so on and they are

processed in order. Note that once you allocate and download all the licenses for a specif ic License Access Code, you

cannot use that License Access Code again. If  you must perform additional transactions with that code, log on to My
Account .

5. To display the newly downloaded licenses, refresh the License Administration Console.

Obtain license files with the License Administration Console

1. For Windows: Start the console ( Start > All Programs > Citrix > License Administration Console).

For License Server VPX and remote systems: Open a web browser and go to https://License Server
Name:secureWebPort .

2. Click Administration and Vendor Daemon Conf iguration.

http://www.citrix.com/English/ss/supportSecond.asp?slID=11553
http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-return-realloc.html
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3. Click Import License.

4. Click the citrix.com link.

5. On the My Account  page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Allocate.

8. Follow the process to allocate and generate your f ile.

9. Select the licenses you want to download, click Download and save the f ile to:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer

/opt/citrix/licensing/myfiles for License Server VPX

10. In the License Administration Console on the Import License File page, browse to the license f ile.

11. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one,

select Overwrite License File on License Server.
12. Click Import License.

13. Click Vendor Daemon Conf iguration and click Administer in the Citrix vendor daemon line.

14. Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses as soon as the licenses are read by the license server.

Manually obtain license files

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account  and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Allocate.

5. Follow the process to allocate and generate your f ile.

6. Select the licenses you want to download, click Download and save the f ile to a directory (remember the location where

you downloaded the f ile; you will need this location). This is the suggested location:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer

/opt/citrix/licensing/myfiles for License Server VPX

7. At the license server, copy the license f ile from the directory where it was saved to the myfiles directory (C:\Program

Files\Citrix\Licensing\MyFiles on a 32-bit computer or C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit

computer or /opt/citrix/licensing/myfiles for License Server VPX).

Tip: Ensure that the license file retains the .lic file extension. Some copy processes do not recognize a file type for that

extension and add a ".txt" file extension during the copy. License files with the wrong file extension cannot be imported.

8. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

/opt/citrix/licensing/LS for License Server VPX

and type the following command: lmreread -c @localhost -all.

Disable domain name truncation on Windows

If  you are hosting multiple tenants on the same License Server, ensure that the License Server does not truncate

@domain.com.

Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system.

Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor

http://www.citrix.com/
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at your own risk. Be sure to back up the registry before you edit it.

1. Locate the registry key:

For 32-bit machines: HKLM\Software\citrix\licenseserver

For 64-bit machines: HKLM\Software\Wow6432Node\citrix\licenseserver

Name: UDUseDomain

2. Set the registry key to 1.

Data Description

0 The domain f ield is truncated. (default)

1 The domain f ield is not truncated.

Disable domain name truncation on the Citrix License Server VPX

1. On the command line, go to the /opt/citrix/licensing/LS/conf/ud_settings.conf  f ile.

2. Using the vi editor, set CTX_UD_USERDOMAIN=1.

3. Restart the License Server VPX or the Citrix Licensing daemon.

Setting Description

CTX_UD_USERDOMAIN=1 Use user domain from user profile. Disables domain name truncation.

CTX_UD_USERDOMAIN=0 Do not use user domain from user profile. (default)

Move license files from an older License Server VPX version

This procedure moves only the license files. You have to reconfigure all the users on the new License Server. Ensure that the

license files that you move have the correct ownership and permissions.

1. Backup the license f iles from the old Citrix License Server VPX to a network share.

All the *.lic license f iles from: /opt/citrix/licensing/myf iles except citrix_startup.lic
2. Shutdown the old License Server

3. Spin up the new Citrix License Server VPX with the same binding as the older one.

Binding could be MAC Address or hostname or IP Address specif ied in the SERVER line of the license f iles.

4. Restore the backed up license f iles from the Network Share to the new License Server. Restore the f iles to:

/opt/citrix/licensing/myf iles with the f ile ownership as ctxlsuser:lmadmin (user:group) and permission as 644 .

5. Run this command as ctxlsuser:  /opt/citrix/licensing/LS/lmreread  -c  @localhost 
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Manually install a certificate used by the Citrix
Licensing Manager

Sep 02, 2014

Create a certificate

To install a certificate, there are three steps:

1. Obtain a .pfx f ile, which contains the certif icate and private key. You can use one of two methods to do this.

2. Extract the certif icate and private key from the .pfx f ile.

3. Install the certif icate and private key on to the License Server.

Step 1, method 1 - Obtain the .pfx file using a domain certificate

Log on to a server in the domain, open the MMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx f ile.

2. Add the Certif icate snap-in by selecting File > Add/Remove Snap-in > Certif icates > Computer account > Local computer.

3. In the left pane under Certif icates, right-click Personal and choose All Tasks > Request New Certif icate, and then click

Next.

4. In the Certif icate Enrollment Policy wizard, choose Active Directory Enrollment Policy, click Next, and then select the

check box next to Computer, and select Details to the right.

5. Select Properties and on the General tab, type a friendly name and description.

6. On the Subject tab, under Subject Type, choose Common name from the Type drop-down menu, type a friendly name in

the text box, click Add, and then click Apply.

7. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment to the

Selected options box.

8. On the Extended Key Usage drop-down menu, add Server Authentication and Client Authentication to the Selected

options box. .

9. On the the Private Key tab and under the Key options drop-down menu, ensure that the Key size is 2048 and select the

Key Exportable check box, and then click Apply.

10. On the Certif ication Authority tab, ensure the CA check box is selected, and click OK > Enroll > Finish.

11. In the Certif icates console, select Personal > Certif icates, click the certif icate you built, select All Tasks > Export > Next,

and select the Yes, Export the Private Key radio button and Next.

12. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all certif icates, click Next, create

a password, and click Next.

13. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to f inish.

Step 1, method 2 - Obtain the .pfx file sending a request to a Certificate Authority (CA)

These steps might vary based on your Certificate Authority.

1. Log on to the License Server, open the MMC, and follow these steps:

1. Add the Certif icate snap-in by selecting File > Add/Remove Snap-in > Certif icates > Computer account > Local

computer.

2. In the left pane under Certif icates, right-click Personal and choose All Tasks > Advance Operations > Create Custom

Request, and click Next.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.31https://docs.citrix.com

3. On the Custom request screen, choose (No template) CNG key from the drop-down menu and PKCS#10 for the

Request format, and click Next.

4. On the Certif icate Information screen, choose Details and click Properties.

5. On the General tab, type a friendly name and description.

6. On the Subject tab, under Subject name, choose Common name and type a value in the text box.

7. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment.

8. On the Extensions tab, choose Enhanced Key usage from the drop-down menu, add Server Authentication and Client

Authentication.

9. On the Private Key tab, choose RSA, Microsoft Software Key Storage Provider (the default) and from the drop-down

menu choose Key options and 2048 for the Key size and Make private key exportable.

10. Save the f ile to a .req f ile, submit the .req f ile to a Certif icate Authority (CA), and save the .cer f ile.

2. In the MMC, select Certif icates > Personal > Certif icates and right-click All Tasks > Import. In the Import wizard, select

the .cer f ile.

3. Create a directory c:\ls_cert to hold the exported .pfx f ile.

4. In the Certif icates console, select Personal > Certif icates, click the certif icate you just imported, select All Tasks > Export

> Next, and select the Yes, Export the Private Key radio button and Next.

5. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all certif icates, click Next, create

a password, and then click Next.

6. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to f inish.

Step 2 - Extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key from a .pfx file.

Important: The version of OpenSSL shipped with the License Server does not support extracting certif icates and private
keys. For information about downloading OpenSSL, go to  www.openssl.org. Citrix recommends installing OpenSSL on a
separate workstation to perform these steps:
1. Navigate to the <openssl directory>\bin folder.

2. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.crt -nokeys
Note: The License Server uses only the .crt certif icate format.

3. Type the password created during the export process (password).

4. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.key -nocerts -nodes
5. Type the password created during the export process (password).

Step 3 - Install the .crt and .key files on the License Server

1. Copy the server.crt and server.key created above to cd \program files (x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\
2. Restart the Citrix Web Services for Licensing service.

Configure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program
(CEIP), and Call Home

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home.  When you configure a proxy server, requests to

download licenses and upload Call Home data is sent through a proxy server.  

To configure a proxy server

1. Edit the SimpleLicenseServiceConf ig.xml f ile, which is in the <citrix Licensing>\WebServicesForLicensing directory. 

2. Add  a line of xml to the f ile in the format <Proxy>proxy server name:port number</Proxy>

Important:  The .xml tags are case sensitive.  

https://www.openssl.org
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<Configurations>

  <EncoreConfiguration>

    <SamplingPeriod>15</SamplingPeriod>

    <RetentionTime>180</RetentionTime>

    <Enabled>true</Enabled>

  </EncoreConfiguration>

  <Proxy>10.211.55.5:808</Proxy>

</Configurations>

Sample file COPY

javascript:void(0)
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Upgrade

Aug 10 , 2016

Each time you upgrade your Citrix product, you should also upgrade the Citrix License Server. Each time a new License Server
is released, it may contain better security, f ixes to known issues, and so on. In some cases, new versions of the Citrix
product will not work with older versions of the License Server.
Note: New versions of the License Server are compatible with older versions of the product and old licenses.
If  you are a current Citrix Subscription Advantage member, you are eligible to version upgrade to the latest release of Citrix

products and upgrade your existing licenses to the license system used by these products.

Version Upgrade means the movement from any previous version of a product to the newest version of the product (for

example, moving from XenDesktop 5.6 to XenDesktop 7.x).

Edition Upgrade means the purchase of a higher edition level of a product (for example, you currently have Enterprise

Edition and you purchase an upgrade to Platinum Edition).

Warning
Upgrades are not supported for License Server VPX. See Move license files from an older License Server VPX version.

Upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward compatible and will work

with older products and license files; however, new products require the newest License Server to check out licenses

correctly. You can install or upgrade the latest version from the Citrix Web site (Downloads page).

Upgrade your licensing components before upgrading your product, if  necessary.

Important
Uninstall any versions of Citrix Licensing older than version 11.3 before installing this version.

Use the new CitrixLicensing.exe file for all installations going forward, except for Active Directory deployments. In that case, use

the .msi. 

Ensure that both .exe and .msi files are present for the installation.

Unsure which version of the License Server you have? See Ensure you have the latest license server.

For information about system requirements, see System requirements.

Note: To avoid the failure of any subsequent License Server upgrades, ensure that you when you installed your License
Server, you successfully configured it with the post installation License Server Configuration tool or uninstalled your
previous License Server.
To upgrade the License Server:

http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html#par_anchortitle_fe32
http://www.citrix.com/English/ss/downloads/index.asp
http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-return-realloc.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-licensing-prerequisites.html
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Download the license components on the Citrix Web site (Downloads page), start the License Server installer

(CitrixLicensing.exe) as an administrator and follow the graphical interface.

To upgrade the License Server f rom your product media:

1. From your License Server, open the media for your product.

2. If  you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.

3. Navigate through the setup wizard screens to Citrix Licensing and follow the instructions.

Upgrade licenses for your edition

If  you decide to run a higher edition of a Citrix product (for example, XenDesktop Enterprise to Platinum), you must

purchase an upgrade license and add it to the License Server. You will also need to change the product edition setting in the

product's user interface. Citrix recommends that you plan to change the product edition setting during a time when there

are not many connections to the affected servers or that you plan to redirect connections to another computer. When

you change the product edition setting, you must restart the product server for changes to take effect. See the product's

documentation for changing the edition setting. If  you add the upgrade license to the License Server before you set the

edition to the new edition, the Citrix product stops accepting new connections.

Note: Licenses from old product editions appear on the Dashboard of the License Administration Console even though
they are no longer valid. If  you do not remove obsolete and/or unnecessary license allocations, you might see persistent
alerts regarding the Subscription Advantage expiration dates of these licenses. You cannot turn these alerts off . The only
impact of leaving obsolete license allocations on License Servers is that you will continue to receive these alerts. If  you
want to remove the licenses, see Delete License Files.
To upgrade edition licenses:

1. From a Web browser, go to http://www.citrix.com.

2. Click Log In and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Upgrade.

5. Follow the site's options and instructions for upgrading your product edition licenses.

6. Either download or order new media. An email message provides you with instructions to return to citrix.com to allocate

or receive additional feature licenses.

7. Log on to www.citrix.com to allocate your licenses, generate a license f ile, download the license f ile to your License

Server, and reread the f ile.

http://www.citrix.com/English/ss/downloads/index.asp
http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-delete-t.html
http://www.citrix.com
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Manage

Mar 16, 2015

The License Administration Console lets you manage and monitor your Citrix licenses through a Web browser.

Use the Dashboard to:

Monitor licenses, license activity, and alerts

Use the Administration area to:

Administer licenses

Configure console users

Configure alerts

Import licenses

Log license management activities

Secure the console server

View system information

Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the

Administration area requires administration privileges and is password-protected.

Open the console on a Windows computer

To open the License Administration Console on the computer on which it is installed:

From the Start menu, select All Programs > Citrix > License Administration Console.

Open the console on a remote server or cluster

Navigate your browser to one of the following URL options:

https://license server name:web service port

https://client access point name:web service port

https://IP:web service port

where:

license server name is the name of your license server

client access point name is the name given to the client access point during cluster configuration

IP is the IP address of the license server

web service port is the port number for the console's Web service

The default Web service port for the console is 8082.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-dashboard.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-vendor-daemon.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-users.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-alertconfig.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-import-licenses.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-logging.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-secure-console.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview/lic-lmadmin-systeminfo.html
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Monitor licenses and alerts

Jan 15, 2013

Use the Dashboard to monitor your license activity. The Dashboard is the default view when you open the License
Administration Console.

License status at a glance

The Dashboard presents a synopsis of your licenses:

Name Description

Product Product, edition, and type of license

SA Date The Subscription Advantage membership expiration date for the product license

In Use
(Available)

The number of licenses currently in use, followed by the total number available for use

Expiration The date the license expires

License Type The type of license, such as concurrent user or system licenses

Hosts The Hosts link appears when licenses are checked out and links to a list of the host names with
licenses in use

About alerts

Dashboard alerts are triggered by licensing events such as the license server stopping or the expiration of a Subscription

Advantage membership. You configure alerts in the Administration area. The list of displayed alerts is updated when the

Dashboard page is reloaded or refreshed.

Alerts about concurrent licenses are tested and triggered at one minute intervals. The "Vendor Daemon Down" alert is

triggered immediately.

There are two categories of alerts:

Critical alerts

Dashboard
Alert

Administration
Name

Triggering Event

The vendor
daemon has
stopped

Vendor daemon
down

The license server stops, unexpectedly or purposely stopped by the administrator

The Out of All the concurrent licenses have been checked out
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concurrent
license has
expired

concurrent
licenses

Licenses for
product_name
have expired

Concurrent
license expired

The license has expired. Note that if  the license is not a type of license covered by
Subscription Advantage, there is no deleterious effect from being expired. For
example, the startup license and evaluation licenses are always "expired" because
they are not covered by Subscription Advantage. You can ignore this alert unless it
is for a license that shows an expired Subscription Advantage date in the
dashboard.

Subscription
Advantage
membership
expired

Subscription
Advantage
membership
expired

The Subscription Advantage membership for a concurrent license has expired

Dashboard
Alert

Administration
Name

Triggering Event

Important alerts

Name of
Alert

Triggering Event

Concurrent
threshold
exceeded

A percentage (specif ied by the administrator) of concurrent licenses have been checked out

Concurrent
license
expiring

A certain number of days (specif ied by the administrator) remains before the concurrent license expires

Subscription
Advantage
membership
expiring

A certain number of days (specif ied by the administrator) remains before the Subscription Advantage
membership for a license expires. Note that if  the license is not a type of license covered by Subscription
Advantage, there is no deleterious effect from being expired. For example, the startup license and
evaluation licenses are always "expired" because they are not covered by Subscription Advantage. You
can ignore this alert unless it is for a license that shows an expired Subscription Advantage date in the
dashboard.

To view alerts

1. On the Dashboard, click the red X icon to view critical alerts or the orange ! icon to view important alerts.

2. Click items in the list to their details.

To clear alerts

Alerts are not cleared automatically when the condition changes. You must clear the alert manually to remove it from the

list.

Click the X icon next to the alert item.
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Change the default and display language

Jan 15, 2013

Change the default language

Administrators can change the default language of the License Administration Console display. The default applies to all
console users. Available languages include:

Chinese (Simplif ied)

English

French

German

Japanese

Spanish

Users can set a display language for the duration of their session. The console display reverts to the default language at

the end of each user session.

1. Click Administration and choose the Server Configuration tab.

2. Click the User Interface bar.

3. From the Default Display Language drop-down list, choose a language.

Change the display language

You can customize your user session by changing the console's display language. The console language reverts to the

default when you log off. You can change the display language:

Select the language you want:

When prompted during logon.

or

By clicking Change Display Language at the bottom left corner of the console
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Change your console password

Nov 19, 2014

You can change your License Administration Console password at any time.

Note: The Windows license server does not support changing Active Directory user and local Windows user passwords.
Active Directory users and local Windows users can change their passwords using their native operating systems. On
Windows, if  you login as a Locally Managed User and then login, you will see the "Change Password" link at the bottom
right corner. But, if  you login as a Windows Active Directory user/admin, you will not get the change password link as you
cannot change passwords for AD users. On License Server VPX, you will always have the "Change Password" link at the
bottom right corner as it does not support AD users.
1. In the bottom right corner of the console, click Change Password. If  you do not see the link, it is because you are in the

Dashboard area and you are not required to enter your credentials. Clicking the Administration option will cause the link

to appear.

2. Type your old password.

3. Type to enter and confirm your new password.

If  you forget your password, contact the console administrator to assign you a new one.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.40https://docs.citrix.com

Secure the License Administration Console

May 29, 2014

Steps you can take to secure the License Administration Console:

Use HTTPS for the console's Web server communications - HTTPS is the default for new installs. If  you are upgrading,

you might still need to do this.

Require users to log onto the Dashboard

Specify a user session timeout

To configure a server certificate file and key file

You can use HTTPS (Hypertext Transfer Protocol Secure) to create a secure channel for console communications over your

network. The License Administration Console is set to HTTPS (port 8082) by default for new installations. If  you use

HTTPS, you must have a valid server certificate. The license server already contains a self-signed certificate, but you can

create your own. If  you create your own certificate and key file, follow these steps to configure it.

1. Copy a valid server certif icate f ile and server certif icate key f ile into the \Licensing\LS\conf\ for Windows or

/opt/citrix/licensing/LS/conf/ Licenser Server VPX folder of the License Server installation directory.

2. Click Administration and select the Server Configuration tab.

3. Click the Secure Web Server Configuration bar.

4. Enter the location of the server certif icate f ile and the server certif icate key f ile.

5. Restart the Citrix Licensing service.

To require users to log onto the Dashboard

You can optionally secure the Dashboard by forcing users to enter a password. The Administration area is password-
protected for all users.
1. Click Administration and select the Server Configuration tab.

2. Click the User Interface bar.

3. Select Require user to log on to view Dashboard.

To specify a session timeout

You can log out users after a specified time of inactivity, ensuring they do not leave the console unattended.

1. Click Administration and select the Server Configuration tab.

2. Click the Web Server Configuration bar.

3. For Session Timeout, enter the number of minutes that a user can remain inactive before being logged out of the

console. The maximum value is 99999 (69 days, 10 hours, 39 minutes).
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Change port numbers

Oct 29, 2013

Licensing installation sets several port numbers for communications. After installation you can use the License
Administration Console to change port numbers.

Console Web Server Port : The HTTPS TCP/IP port that the Web server uses to listen for communication with clients

connecting to the License Administration Console. By default, the port is set to 8082. If  you are already using that port

number for another application, you can change it to a range between 1 and 65535. If  you are upgrading, you will

maintain your previous configuration and might not get HTTPS by default. If  you change the port, you must stop and

restart the Citrix Licensing service.

License Server Manager Port : This port number is used by the license server manager, which handles the initial

communication between the products, starts the vendor daemon, and relays check out and check in requests to the

vendor daemon. By default, this port number is 27000.

Tip: You can verify which port number is being used from the System Information tab in the Administration area.

Vendor Daemon Port : This port number is used by the Citrix vendor daemon, which is responsible for the core

operations of the license server, including license allocation. By default, this port number is 7279; however, you may need

to change it if  you have a f irewall or if  the number is already in use.

T ip: You can verify which port number is being used from the Vendor Daemon Configuration tab in the Administration

area.

When using the License Administration Console you no longer need to use the License Server Port Utility to change port

numbers. The License Server Port Utility was used to change port numbers before this functionality was developed in the

License Administration Console.

Note: The Linux kernel reserves Ports 1-1024. When configuring the VPX ports, use ports above 1024. If  you use SSL, use
port 8082, which is open in the f irewall. If  you choose a different port for SSL, reconfigure the f irewall in the iptables.

To change the console port

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab.

3. Click the Web Server Configuration bar.

4. In the HTTPS Port f ield, modify the current port number and click Save.

5. In the host machine operating system open the Services panel and select the Citrix Licensing service.

6. Restart the Citrix Licensing service.

To change the license server port

This procedure changes the port number used by the License Server Manager (lmadmin.exe).

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab.

3. Click the License Server Configuration bar to display the associated options.

4. Click the Use this Port radio button and type the new port number in the adjacent f ield. Click Save to save the new port

number.

5. Restart the Citrix Licensing service.

To change the vendor daemon port
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1. In the top right corner of the console, click Administration.

2. Click the Vendor Daemon Configuration tab.

3. Select the Citrix vendor daemon from the table.

4. Under Vendor Daemon Port, set the new port number.

5. Click Save.

6. Restart the Citrix Licensing service.
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Import license files

May 29, 2014

After generating your license file from citrix.com, you are ready to import it into the license server. A startup license is

imported during the license server installation to allow Citrix products to communicate with the license server.

1. After generating and downloading your license f ile, copy the f ile to the computer hosting the license server and console.

The default location for storing the license f ile is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer,

C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer, and /opt/citrix/licensing/myfiles for License Server

VPX.

Tip: Ensure that the license f ile retains the ".lic" f ile extension. Some copy processes do not recognize a f ile type for that

extension and add a ".txt" f ile extension during the copy. License f iles with the wrong f ile extension cannot be imported.

2. For Windows: Start the License Administration Console from the programs menu: Citrix > License Administration

Console.

For License Server VPX and remote systems: Open a web browser and go to https://License Server

Name:secureWebPort.

3. Start the console and click Administration.

4. Log on and click the Vendor Daemon Configuration tab.

5. Click Import License.

6. Browse to the license f ile.

7. If  you copied the f ile directly to the myfiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

8. Click Import License. The import process copies the f ile from its existing location into the MyFiles directory where it can

be read by the license server.

9. Click Administer in the Citrix vendor daemon line.

10. Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses as soon as the licenses are read by the license server.

To use the command line

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Allocate.

5. Follow the process to allocate and generate your f ile.

6. Select the licenses you want to download, click Download and save your license f iles. You can save the f iles directly to

the default location. The default locations where license f iles are kept are:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

7. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

/opt/citrix/licensing/LS for License Server VPX

and type the following command: lmreread -c @localhost -all.

http://www.citrix.com
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License administration

Jun 30 , 2014

After you have imported your license files, they are administered by the Citrix vendor daemon (CITRIX). The Citrix vendor

daemon is responsible for the core operations of the license server, such as tracking how many licenses are checked out

and who has them. The vendor daemon can manage all of your Citrix license files and is fully backward compatible with any

license files you have. Set properties for the vendor daemon on the Vendor Daemon Configuration page of the console.

Note: You can manage only the Citrix vendor daemon with this console.

Configuring the vendor daemon

The Vendor Daemon Configuration page allows you to import license files, configure the vendor daemon, and view logs

about license activity. Only users with Administrator privileges can view this page.

Click Administer in the vendor daemon summary grid to set these options:

Option Description

Vendor
Daemon Port
in Use

The TCP/IP port number that the vendor daemon uses for communication with products.

Stop Stops the vendor daemon, but leaves the console running. When you stop a vendor daemon, this
button changes to Start. Disabled by default.

Start Starts the vendor daemon and reads the license f iles. This button only appears when the vendor
daemon is stopped. When you start a vendor daemon, this button changes to Stop.

Reread
License Files

Rereads the contents of the license f iles and the options f ile.

Report Log
Name

This option is not functional.

Rotate
Report Logs

This option is not functional.
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Configure console users

Aug 08 , 2014

The License Administration Console can use License Administration users, local Windows users and groups, and Active

Directory users and groups. The Citrix Licensing Manager can use local Windows users and groups and Active Directory users

and groups. The License Administration Console manages them all. These users are not connected to the computer's local

users.

The Active Directory users and groups are part of an Active Directory/network authentication system. To support Active

Directory users and groups, the Windows license server must be a member of a Microsoft Active Directory domain and must

be running the License Administration Console. Windows NT domains are not supported.

Note
The License Server VPX does not support Active Directory or the Citrix Licensing Manager.

Users are configured with local roles. All users are created as administrators and can:

View the Dashboard for license activity and alerts.

Change their own password. Active Directory users and groups do not have passwords associated with them. They

contact Active Directory to be authorized and follow standard Active Directory user password policies.

Select a console display language.

Change their own password.

Select a console display language.

View system information.

Add and delete users and expire their passwords. You can expire passwords for local users only.

Configure alerts.

Configure the license server.

Configure the vendor daemon.

Stop the license server after you have made changes to it.

Configure the administration console.

Configure, and add licenses with, the Citrix Licensing Manager.

Administrators must enter user name and password when opening the Administration area. Settings in Server Configuration

allow you to optionally secure the Dashboard by requiring users to log on. If  Password Protected Dashboard is enabled ALL

users accessing the License Administration Console must log on.

What types of  accounts are added at installation

A default administrator account is created during installation of the License Administration Console. Use the administrator

account to first log on to the console and then configure additional users.

During installation of the License Administration Console, accounts are added based on machine membership. For

workgroup machine installations, computer\InstallUser and BUILTIN\Administrators are added. For Active Directory

installations, domain\InstallUser and BUILTIN\Administrators are added. You can remove any of these accounts after

installation, but ensure that there is at least one administrator.
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Note
If an "admin" user remains after an upgrade, the domain administrator can delete that user.

Add locally managed users

1. Click Administration and then the User Configuration tab.

2. Click New Users.

3. Select Locally Managed Admin from the drop-down menu.

4. Type information based on the Role chosen. Required f ields are identif ied with an asterisk (*).

User names are case sensitive and cannot contain a backslash (\).

5. Optionally select the User must change password on next logon check box to force the user to create a new password.

Add local Windows users and domain users and groups

1. Click Administration and then the User Configuration tab.

1. If  you are adding domain users or groups, click Domain Users/groups.

2. Click New Users.

3. Select a role from the drop-down menu.

4. Type information based on the Role chosen. Required f ields are identif ied with an asterisk (*).

Users and groups must be created as domain\user (domain can refer to a machineName) or domain\group.

Local Windows users must be created as computer\user.

For domain users, names are converted to upper case and stored. An upper case domain user name (for example,

TEST\HARVEY) can coexist with a lower case local user name (for example, test\harvey), but an upper case domain

user cannot coexist with an upper case local user name.

Change a user password for locally-added users

1. On the User Configuration page, click Edit in the line containing the user's record.

2. Type and confirm the new password.

3. Optionally select the User must change password on next logon check box to force the user to change the new

password.
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Configure licensing alerts

Jan 15, 2013

Alerts display on the Dashboard and are classified as critical or important. Administrators can select which alerts appear on

the Dashboard and set the thresholds that trigger them.

1. In the top right corner of the console, click Administration and select the Alert Configuration tab.

2. Select the alerts you want to display on the Dashboard, and for the important alerts determine the threshold to trigger

the alert.

3. Click Save.

4. By default, Subscription Advantage membership alerts are also displayed on the Dashboard. To turn on or off  these

alerts:

1. Click Vendor Daemon Configuration.

2. Select the Citrix vendor daemon.

3. Select or clear Enable Subscription Advantage membership expiration alerts for this vendor daemon.
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Improve performance by specifying thread use

Oct 29, 2013

Requests come in to the license server through a listener port. All communication must be accepted by an acceptance
thread. If  the message is accepted, a receive thread handles it and then a processing thread processes it. To improve license
server performance when receiving a large number of requests, you can configure the maximum number of receive and
processing threads to use.
When a program initiates an I/O request (an example would be a request to check-out a license), it creates and uses a

thread. The thread maintains the place and data in the program as a reference point, and once the request is complete, the

program can be re-entered at the same point. You can have many requests at the same time, depending upon how many

threads are allowed. This is called multi-threading.

The optimal values needed for acceptable license server performance are dependent on the hardware, the site
configuration, and the request volume. If  you set the limits too high and your hardware cannot support it, it will slow down
the communication. If  you set the limits too low, it will take longer for the communication to occur as the system will wait
until it can create more threads before it executes incoming requests. You should test and evaluate different values to
determine the configuration that meets your site's needs. A good starting point for a large scale deployment might be
setting the Maximum Number of License Server Manager Processing Threads to 30 and the Maximum Number of License
Server Manager Receiving Threads to 15.
There are two areas where you can specify the thread limits:

License Server

Web Server

To set license server thread use

1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab and the License Server Configuration bar.

3. Modify the Maximum Number of License Server Manager Processing Threads and Maximum Number of License Server

Manager Receiving Threads f ields (up to 999 threads).

4. Restart the Citrix Licensing service.

To set Web server thread use

Use this procedure to set the maximum number of threads that the Web server for the License Administration Console uses
to process requests. Specify a larger number if  you expect many users to simultaneously access the console.
1. In the top right corner of the console, click Administration.

2. Click the Server Configuration tab and the Web Server Configuration bar.

3. Modify the Maximum Number of Web Server Threads f ield (up to 999 threads).

4. Restart the Citrix Licensing service.
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View system information

Jun 30 , 2014

You can view system information about the license server and the system running the license server. The following

information is available by clicking the Administration option in the top right corner of the License Administration Console,

followed by the System Information tab.

Name Description

Release Version The version of the license server.

License Server
Manager Port
Number in Use

The port number that the license server uses to communicate with the products.

Display On Windows, this is the system name or the terminal server client name (in a terminal server
environment).
On UNIX, this is the X-Display name or the value returned by the ttyname() (or comparable) function.

Host Name The name of the computer hosting the license server.

Host Domain
Name

The fully-qualif ied name of the computer hosting the license server.

IPv4 Address The IP version 4 address of the computer hosting the license server. The IPv4 address appears only if
the computer has IPv4 enabled.

IPv6 Address The IP version 6 address used to identify the computer hosting the license server. The IPv6 address
appears only if  the computer has IPv6 enabled.

Ethernet
Address

The Ethernet address (also known as the MAC address) of the computer hosting the license server.

Local Stop
Server Allowed

Displays either yes or no. If  it is no, you cannot stop the license server using the lmdown utility or the
console. Configure this property using the -allowStopServer command line option when you run the
license server manager (lmadmin). Disabled by default.

Remote Stop
Server Allowed

Displays either yes or no. If  it is no, you cannot stop the license server from a remote machine using
lmdown or the console. Disabled by default.
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Logs

Jul 15, 2014

Log files are stored in:

C:\Program Files\Citrix\Licensing\LS\Logs on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\LS\Logs on a 64-bit server

C:\Program Files (x86)\Citrix\Licensing\WebServicesForLicensing\Logs on a 64-bit server

/opt/citrix/licensing/LS/logs for VPX

Log File name Viewable f rom What it  logs

License
server log

lmadmin.log Server Configuration > Logging License server, console, and administration
activities

Vendor
daemon log

citrix.log Vendor Daemon Configuration >
Vendor Daemon Log

Licenses and license activities

Access log access.log logs folder HTTP access events
Note: This log is used by support personnel for
debugging purposes only.

Web log web.log logs folder Web server information
Note: This log is used by support personnel for
debugging purposes only.

Some versions of the license server (previous to 11.6.1) included a report log. The License Administration Console does not

include a report log. If  you have a legacy report log file (C:\Program Files\Citrix\Licensing\LS\reportlog.rl for Windows or

/opt/citrix/licensing/LS/reportlog.rl for License Server VPX), it will not be updated unless you relocate the file "reportlog.rl"

to the logs directory and update the options file to control it.

To view and configure the license server log

1. In the Administration area, on the Server Configuration page, click the Logging bar.

2. Click View log f ile.

3. To change the level of logging, select the type of information to be recorded from the Log Level dropdown list.

Note: Leave this property set to the default setting of Information unless you are instructed by support personnel to

change it to aid in troubleshooting.

To view the vendor daemon log

This procedure displays the latest 200 lines of data in the file. You can view the entire contents of the log (citrix.log) by

opening it directly from the \\Program Files\Citrix\Licensing\LS\Logs folder for Windows or the /opt/citrix/licensing/LS/logs

folder for License Server VPX.

1. In the Administration area, on the Vendor Daemon Configuration page, click the Vendor Daemon Log bar.

2. Click View log f ile.

To configure the vendor daemon log
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1. In the Administration area, on the Vendor Daemon Configuration page, click the Vendor Daemon Log bar.

2. Select whether to overwrite or append to the log:

Option Description

Overwrite
Vendor
Daemon Log

When selected, this option overwrites the log when you restart the Citrix Licensing service or the

vendor daemon. If  the option is clear, the log entries are appended to the end of the f ile.

Vendor
Daemon Log
Location

Changing log location is not recommended.

3. Click Save.

4. Click Stop under Vendor Daemon Actions.

5. Click Administer on the Vendor Daemon Configuration page and then Start under Vendor Daemon Actions.
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Set the default language

Jan 15, 2013

Administrators can change the default language of the License Administration Console display. The default applies to all
console users. Available languages include:

Chinese (Simplif ied)

English

French

German

Japanese

Spanish

Users can set a display language for the duration of their session. The console display reverts to the default language at

the end of each user session.

1. Click Administration and choose the Server Configuration tab.

2. Click the User Interface bar.

3. From the Default Display Language drop-down list, choose a language.
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License files

Mar 16, 2015

When you install the license server, a startup license and an options file are installed automatically. To license your Citrix

products you add one or more license files. See "Obtain your license files" in Get started with Citrix Licensing for information

about adding your product licenses.

You cannot change the location of license files on the license server. License files must reside in their default location.

Startup license f ile

The startup license f ile (citrix_startup.lic) is a text f ile that is used by Citrix products to communicate with the license server

using a continuous open connection. Every f ive minutes the license server and the product send a heartbeat message to

each other to verify that they are mutually communicating. If  the product and the license server have been exchanging

heartbeat messages but there is an interruption in the exchange (for example, there is a power failure), the product goes

into a grace period. The startup license does not affect your license count. Do not edit this f ile.

Note: Some Citrix products can operate in a disconnected mode (not connected to the server). These products allow a user

to check out a license and operate the product for a preconfigured period of time that is set by the administrator. In this

case, heartbeat messages are not exchanged.

You can control different aspects of your licensing operations and environment by customizing the license file.

License f ile

The license file is a text file that contains product licensing information as well as the license server name (or other binding

identifier), the Subscription Advantage membership renewal date (also known as the Subscription Advantage Expiration

date), the license expiration date (if  applicable), and other system information. All of this information is encrypted with a

digital signature. When you purchase a Citrix product, you go to the citrix.com Web site to download a license file. You can

have more than one license file per license server. The license file resides in the C:\Program Files\Citrix\Licensing\MyFiles

directory on a 32-bit server, the C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server or in the

/opt/citrix/licensing/myfiles directory for License Server VPX where it is referenced by the license server. The license server

uses this file(s) to determine whether or not to grant a license to a Citrix product.

Move license files to a different host

If  you need to move your license files to a server with a different hostname or MAC address, you cannot use the license

files that you downloaded for the old license server. Create new license files that reference the new server name by

reallocating them.

See Reallocate license files for more information.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-getting-started.html
http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-return-realloc.html
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License file format

Apr 08 , 2013

Important
Modifications can make license files unusable. If using Citrix Licensing for Windows 11.6.1 or later, you should never need to edit license files. You can manage licenses and their tasks through the License Administration

Console and the My Account site.

Note: You can change the name of the license f ile, but it must have a .lic extension.
Citrix License files employ the following naming convention: license_FID_XDT-PLT-UD_25-mar-2013.lic.

License files are composed of lines that list specific information, such as the server name (SERVER) or quantity of licenses (INCREMENT). These lines begin with words denoting their purpose in

uppercase letters, such as VENDOR, SERVER, INCREMENT, USE_SERVER, and so on.

The following sections provide in-depth information about the following elements of license file syntax: the SERVER line, VENDOR line, USE_SERVER line, INCREMENT line, and UPGRADE line. While

the term feature is used in the options and license file syntax, in this document, the term product license is used whenever possible for clarity.

Example license f ile with numbers corresponding to the explanations following the example:

1 SERVER Line

The SERVER Line. The SERVER line specif ies the binding identif ier (also known as the hostname) of the license server.
Caution: Do not modify the binding identif ier on the SERVER line; otherwise, the license f ile will not work.
Syntax

SERVER this_host ether

or

SERVER this_host HOSTNAME=hostname

Parameters Description

ether The MAC address of the appliance on which the license server is running. Do not edit this string.

hostname The name of the computer on which the license server is running. Do not edit this string.

Example

SERVER this_host HOSTNAME=license_server1

2 VENDOR Line

The VENDOR line specifies the Citrix vendor daemon name.

Syntax

VENDOR CITRIX [vendor_daemon_path]

Field Description

VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit this name.

vendor_daemon_path Path to the executable for the Citrix vendor daemon. Citrix recommends that you do not change this path.

3 INCREMENT Lines

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or more INCREMENT lines. Each INCREMENT line makes up a user-specified allocation of product

and license (users, connections) counts..

Each increment line contains a signature based on the data in that line, the hostids specif ied in the SERVER line(s), and data chosen by Citrix. INCREMENT lines use a backslash ( \ ) to wrap long lines
of text.
Syntax

INCREMENT feature vendor SA_expiry_date exp_date num_lic \ 
  SIGN=sign [optional_attributes]
Caution: Do not modify the six f ields after the INCREMENT line keyword; they are required and have a f ixed order.
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The following table explains these f ields in the order they appear:

Field Description

feature The product license. Do not edit this line.

vendor Indicates this license is for a Citrix vendor daemon. Do not edit this line.

SA_expiry_date Indicates the date until which you are entitled to product version upgrades. If  you do not have a Subscription Advantage membership or this is not a Subscription Advantage

license, the date indicates when you ordered or redeemed the license. Do not edit this line.

Note: If  you renewed your Subscription Advantage membership and received an upgrade license, two dates are listed.

The f irst date is the date when the Subscription Advantage membership was originally purchased

The second date is the SA_expiry_date

Example:

INCREMENT MPS_ENT_CCU CITRIX 2005.0311 2007.0311 permanent 1000 \

See Upgrade Lines for additional information.

exp_date Expiration date of license in the format dd-mmm-yyyy, that is, 07-may-2006. Do not edit this line.

Note: If  the exp_date f ield contains the string "permanent," the license never expires.

num_lic Number of concurrent licenses for this product license. Do not edit this line.

SIGN=sign SIGN= signature to authenticate this INCREMENT line. Do not edit this line.

INCREMENT lines also determine the grouping of licenses in the management console. These groups are known as license pools. The Citrix vendor daemon creates the license pools based on

common attributes, such as product license or version. When a new pool is created, the console displays and tracks this pool independently from other license pools. When two or more attributes are

different, the Citrix vendor daemon creates a new license pool.

Citrix Attributes in INCREMENT Lines

INCREMENT lines can also include additional attributes from Citrix. These attributes provide information about the license, such as the date on which it was issued or that the license is an upgrade

license.

Caution: Do not modify or delete these attributes.

Example

Important items are highlighted in the above example:

The Product (license feature) appears in blue

The Citrix Subscription Advantage expiration date appears in red (Format: YYYY.MMDD)

The License (user, connection) Count appears in GREEN

Syntax

keyword=value

The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that this attribute is not editable.

Attribute Description

DUP_GROUP=V This attribute allows license sharing for the same client device.

ISSUED=dd-mmm-yyyy Date issued.

ISSUER="..." Issuer of the license.

NOTICE="..." Your company's name.

SN=serial_num A number that is used to identify INCREMENT lines.

START= dd-mmm-yyyy The date from which you can use a license. The license server cannot use licenses before their start date.

SUPERSEDE="MPS_ADV_CCU

MPS_STD_CCU ..."

This appears in the upgrade license f ile when you move to a higher product edition. If  this appears, all licenses issued before the date specif ied in ISSUED=

are superseded by this line and become ineffective.

VENDOR_STRING="..." String defined by Citrix.

Optional Attributes in INCREMENT Lines

INCREMENT lines contain several attributes that you can add, edit, or delete. You can add attributes, if  desired. For example, you can insert an asset tag or a purchase order number beside each

license in a f ile. Likewise, you can add attributes that indicate a specif ic group of licenses is dedicated for a department in your organization.

Some of these attributes may be inserted by Citrix or your Value Added Reseller.
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Optional attributes are listed in the table that follows. Like the Citrix-specif ic attributes, the optional attributes have a keyword=value syntax where keyword is in lowercase. You can tell the

difference between optional and required attributes by the case of the letters: optional attributes have lowercase letters.

Attribute Description

asset_info= "..." Additional information you can add for asset management

dist_info= "..." Additional information provided by the software distributor

user_info= "..." Additional information provided by the license administrator

vendor_info= "..." Additional information provided by Citrix

UPGRADE Lines

An UPGRADE line indicates the date when a Subscription Advantage membership was renewed and the date it expires.
Caution: Do not modify this line.
Syntax

UPGRADE feature CITRIX from_Subscription_Advantage_date 
to_Subscription_Advantage_renewal_date 
exp_date num_lic \ 
[options ... ] SIGN=sign
All the data is the same as for an INCREMENT line, with the addition of the from_Subscription_Advantage_date f ield. An UPGRADE line removes up to the number of licenses specif ied from any old

version (>= from_Subscription_Advantage_date) and creates a new version with that same number of licenses.

Example 1

For example, the following lines renew the ABCD Corporation's Subscription Advantage membership for 1000 MPS_ENT_CCU licenses for one year (until March 11, 2006):

INCREMENT MPS_ENT_CCU CITRIX 2005.0311 permanent 1000 \ VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ DUP_GROUP=V ISSUED=12-Mar-2004 NOTICE="ABCD Corporation" \ SN=LA-0000150712-12345:123 START=11-mar-2004 SIGN="1234567"
UPGRADE MPS_ENT_CCU CITRIX 2005.0311 2006.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2005 NOTICE="ABCD Corporation" \ 
 SN=RE-0000164638-12345:123 START=11-mar-2005 SIGN="1234567"
Example 2

For example, the following lines renew the ABCD Corporation's Subscription Advantage membership for 1000 MPS_ENT_CCU licenses for one year (until March 11, 2006):

INCREMENT MPS_ENT_CCU CITRIX 2005.0311 permanent 1000 \ VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ DUP_GROUP=V ISSUED=12-Mar-2004 NOTICE="ABCD Corporation" \ SN=LA-0000150712-12345:123 START=11-mar-2004 SIGN="1234567"
UPGRADE MPS_ENT_CCU CITRIX 2005.0311 2006.0311 permanent 1000 \ 
 VENDOR_STRING=;LT=Retail;GP=96;CL=ENT,ADV,STD;SA=1;ODP=0 \ 
 DUP_GROUP=V ISSUED=12-Mar-2005 NOTICE="ABCD Corporation" \ 
 SN=RE-0000164638-12345:123 START=11-mar-2005 SIGN="1234567"
An UPGRADE line applies to the closest preceding INCREMENT line with a Subscription Advantage date that is greater than or equal to from_Subscription_Advantage_date, and less than

to_Subscription_Advantage_renewal_date.

Upgrade lines use a continuation character ( \ ) to break up long lines. When using license f iles with an UPGRADE line, you must keep the license f iles with the original INCREMENT lines in the same

folder.
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Reallocate license files

May 29, 2014

License files run only on the license server or hardware appliance that was specified when they were generated. If  you

change the binding identifier of a server or appliance hosting license files, you must reallocate license files so that they

match the new binding identifier.

The binding identifier is the information in the license file that identifies the machine where the license file is hosted. The

binding identifier is usually the license server hostname, but it can also be a hardware appliance name, Ethernet address

(MAC address), or FQDN.

Situations in which you might need to reallocate a license f ile:
You rename your license server

You want to move your license f iles to a server with a different name

You used some licenses initially to create a test environment and now you want to reuse those licenses on a different

license server

Designating a new binding identifier when you reallocate licenses does not consume additional licenses. The process

changes only the binding identifier for the licenses.

To reallocate license files with the License Administration Console

1. For windows: Start the console (Start > All Programs > Citrix > License Administration Console). 

For License Server VPX: Open a web browser and go to https://License Server Name:secureWebPort.

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Reallocate.

8. Select the check boxes preceding the licenses you want to reallocate, click Continue.

9. On the pages that follow, follow the instructions to select the licenses to be reallocated into the new file (and

associated with a new license server) and download the license f ile.

10. Save the f iles to a location such as your desktop (remember the name of the f iles and location where you downloaded

the f ile; you will need this location). You can save the f ile directly to the default location. The default locations for

license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

11. In the License Administration Console on the Import License File page, browse to the license f ile.

12. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

13. Click Import License.

14. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

15. Click Reread License Files to allow the license server to recognize the new file.

To reallocate license files without the console
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1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Reallocate.

5. Select the check box preceding the licenses you want to reallocate, then click Continue.

6. On the pages that follow, follow the instructions to select the licenses to be reallocated into the new file (and

associated with a new license server) and download the license f ile.

7. Save the f ile to a location such as your desktop (remember the name of the f ile and location where you downloaded the

file; you will need this location). You can save the f ile directly to the default location. The default locations for license

files:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

8. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

/opt/citrix/licensing/LS for License Server VPX

and type the following command: lmreread -c @localhost -all.

http://www.citrix.com
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Replace (redownload) license files

May 30 , 2014

Replacement license files are copies of license files you previously generated. You might need to download replacement files

if  you corrupt or delete a license file. You can choose how to redownload the licenses by using the By Host or By Allocation

tabs.

To redownload license files using the License Administration Console

1. For windows: Start the console (Start > All Programs > Citrix > License Administration Console). For License Server VPX
and remote systems: Open a web browser and go to https://License Server Name:secureWebPort.

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Redownload.

8. Click Select All to select all items on all pages, click the Page check box to select all items on that page, or select the

check boxes preceding the licenses that you want to download.

9. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

10. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

11. Click Import License.

12. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

13. Click Reread License Files to allow the license server to recognize the new file.

To redownload license files without the console

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. From the main menu, select Redownload.

4. Click Select All to select all items on all pages, click the Page check box to select all items on that page, or select the

check boxes preceding the licenses that you want to download.

5. Click Download and save the f ile to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

6. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

http://www.citrix.com
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/opt/citrix/licensing/LS for License Server VPX

and type the following command: lmreread -c @localhost -all



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.61https://docs.citrix.com

Combine license files

May 30 , 2014

If  you are accumulating a lot of license files on a license server, you can combine the licenses into one license file. License

files can accumulate when you:

Purchase additional licenses

Renew your Subscription Advantage membership

Tip: Back up and then delete the old license f iles from the license server before replacing them with the new files.

To combine files using the License Administration Console

1. For windows: Start the console (Start > All Programs > Citrix > License Administration Console). For License Server VPX
and remote systems: Open a web browser and go to https://License Server Name:secureWebPort.

2. Click Administration and Vendor Daemon Configuration.

3. Click Import License.

4. Click the My Account link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Redownload.

8. Use the By Host tab (to automatically combine all specif ied licenses allocated to a host ID into single line item) and click

Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check

boxes preceding the licenses that you want to download.

9. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

10. In the License Administration Console on the Import License File page, browse to the license f ile.

11. If  you copied the f ile directly to the MyFiles directory, or if  the f ile has the same name as an existing one, select

Overwrite License File on License Server.

12. Click Import License.

13. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

14. Click Reread License Files to allow the license server to recognize the new file.

To combine files without the console

1. From a Web browser, go to http://www.citrix.com.

2. Click My Account and enter your user ID and password.

3. Select All Licensing Tools.

4. From the main menu, select Redownload.

5. Use the By Host tab (to automatically combine all specif ied licenses allocated to a host ID into single line item) and click

Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check

boxes preceding the licenses that you want to download.

6. Click Download and save the f iles to a location such as your desktop (remember the name of the f ile and location where

you downloaded the f ile; you will need this location). You can save the f ile directly to the default location. The default

http://www.citrix.com
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locations for license f iles:

C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

7. At a command prompt, navigate to:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

/opt/citrix/l icensing/LS for License Server VPX

and type the following command: lmreread -c @localhost -all
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Delete license files

Dec 14 , 2016

When you upgrade your edition (for example, Advanced to Enterprise, or Enterprise to Platinum) you receive new Citrix

product licenses that you can allocate to one or many Citrix License Servers through license files created at citrix.com.

Rescinded licenses must be removed from license servers within ninety (90) days of new license purchase. Removing the

licenses enables:

License asset management

License compliance

Remove unnecessary alerts from appearing in the management console

Considerations when deleting f iles:
Incorrect removal of license f iles could inadvertently lower the total licenses available.

Place any new license f iles on the license server prior to deleting any licenses.

Remove a license f ile only when all INCREMENT lines in the f ile are obsolete or unnecessary. For example, every

increment line has been replaced with a new license as a result of an upgrade.

If  you used the License Administration Console to add license f iles, you have to update the console UI for any deleted

files.

Important
Never delete the options file (citrix.opt) or startup license (citrix_startup.lic).

1. At the license server, open the Services panel and stop the Citrix Licensing service.

2. Open Windows Explorer and navigate to where the license f iles are stored. By default license f iles are stored in:

C :\Program Files\Citrix\Licensing\MyFiles on a 32-bit server

C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server

/opt/citrix/licensing/myfiles for License Server VPX

3. Back up all license (.lic) f iles.

4. Using a text editor (Microsoft WordPad is recommended), open each license (.lic) f ile and identify the obsolete license

feature INCREMENT line(s).

5. Ensure all increment lines are obsolete or unnecessary. See License f ile format for information about increment lines.

6. Close the f ile and change the f ile extension from .lic to .old.

7. In the Services panel, restart the Citrix Licensing service.

To update the License Administration Console UI

If  you added license files with the console, you must update the console UI after removing those files.

1. Start the console and click Administration.

2. Log on as an administrative user and click the Vendor Daemon Configuration tab.

3. Select the Citrix vendor daemon from the list.

4. Edit the contents of License File or Directory to remove any deleted licenses and then save the configuration.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-license-format-r.html
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License administration commands

Mar 16, 2015

While the License Administration Console provides an easy method of accessing many licensing features, you can also

perform licensing tasks using commands. You might use license administration commands when performing advanced

operations on the license server that are not available in the console. Such operations include diagnosing check-out

problems using lmdiag.

License administration commands are stored in:

C:\Program Files\Citrix\Licensing\LS on a 32-bit computer

C:\Program Files (x86)\CCitrix\Licensing\LS on a 64-bit computer

/opt/citrix/licensing/LS for License Server VPX

Table of  commands

Utility Description

lmadmin Provides licensing configuration. Use the License Administration Console for licensing configuration and
administration tasks. Do not use lmadmin.

lmdiag Diagnoses license check-out problems.

lmdown Gracefully shuts down the License Manager and Citrix vendor daemons (disabled by default).

lmhostid Reports the host ID of the server on which Citrix Licensing is running.

lmreread Causes the License Manager daemon to reread the license f ile and start the Citrix vendor daemon.

lmstat Displays the status of a license server.

lmutil Displays a list of licensing utilities or executes other commands.

lmver Displays version information for the licensing binaries. 

udadmin Displays all licensed users and devices and deletes specif ied licensed users and devices. This command applies
to User/Device licenses only.

Format license commands

Formatting conventions for the license administration commands:

Convention Description

Bold A command or switch, such as lmstat.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-lmadmin-overview.html
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Italic You need to replace variables with a value; for example, in the expression:
lmstat -clicense_file_list

Before you run the command you must replace license_file_list with the names of one or more license

files.

[square
brackets]

Square brackets around text indicate options that can be added to the command or that text within
the brackets needs to be replaced.

Convention Description

Universal arguments

Valid arguments for most license administration commands:

Argument Description

-all Applies the command to all of the license servers on the network.

-c Lets you specify license f ile(s) or license server port and host name.
If  you specify the path without a license file name, the command applies to all the license files in the

directory.

For a local host: -c @localhost

For a remote license server: -c @servername

For a license server in a cluster: -c @clientaccesspointname

For a specified path: -c path

For the names of one or more license files: -c license_file_list

You can enter more than one license file path by separating each path with a semicolon.

Path names that include spaces must be enclosed in double quotes.

-h License handle, as reported by lmstat -a. The license handle is a number used to identify a specif ic checked
out license.

-help Displays usage information and exits.

-s [server] Displays the status of all license f iles listed on the license server or on all license servers, if  server is not
specif ied.

-verbose Displays a longer description for all errors found.

Diagnose checkout problems (lmdiag)

lmdiag allows you to diagnose problems when a product cannot check out a license. In particular, you can test if  your
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licenses are valid and if  the license server is running. When you run this utility, it attempts to check out a license.

You can also use the lmdiag utility to see if  a specific type of license is working. For instance, you can run lmdiag on your

Citrix XenApp server, Advanced edition licenses only by specifying MPS_ADV_CCU as an argument.

Syntax

lmdiag -c l icense_fi le_l ist [-n] [feature[:keyword=value]]

Argument Description

-c

license_file_list

Diagnoses the specif ied f iles. You can also use:-c @localhost or -c @server-name

-n Runs in non-interactive mode; lmdiag does not prompt for any input in this mode.

feature Limits the feedback to the specif ied feature.

keyword=value If  a license f ile contains multiple lines for a particular feature, the result is limited to the line
containing the text value. For example:
lmdiag -c @localhost MPS_ENT_CCU:HOSTID=LICSERV01
attempts a checkout on the line with the host ID "LICSERV01."

Keyword is one of the following: VERSION, HOSTID, EXPDATE, KEY, VENDOR_STRING, ISSUER

If no feature is specified, lmdiag operates on all features in the license files in your list. lmdiag displays information about the

license, then attempts to check out each license. If  the check out succeeds, lmdiag indicates success. If  the check out fails,

lmdiag gives you the reason for the failure. lmdiag attempts to connect to each TCP/IP port on the license server. It

detects if  the port number in the license file is incorrect. lmdiag lists each TCP/IP port number that is listening, and if  -c

license_file_list is specified, diagnoses the specified files.

lmdiag does not contact the computer running the Citrix product when it attempts to check out licenses. lmdiag indicates

only if  there are problems on the license server. That is, your product cannot check out licenses because it is pointing to the

wrong license server (for example, a license server that does not have licenses for that product on it), but lmdiag does not

detect this problem. lmdiag reports that it can check out licenses when the Citrix product is pointing to the wrong license

server.

Stop daemons (lmdown)

The lmdown utility shuts down the License Manager daemon and the Citrix vendor daemon on your license server or all

license servers on your network but is disabled by default. To enable it:

1. Stop the license service.

2. Run lmadmin - allowStopServer and/or -allowRemoteStop Server.

3. Restart the license server.

Syntax
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lmdown -c l icense_fi le_l ist [-vendor CITRIX] [-q] [-al l]

Argument Description

-c @localhost  

or

-c@server

or

-c

license_file_list

Use the specif ied license f iles. Note that specifying -c license_file_list is always recommended with
lmdown. You can also use:-c @localhostor -c @server-name

-vendor
CITRIX

Shut down only the Citrix vendor daemon. The License Manager daemon continues to run.

-q Do not prompt or print a header. Otherwise lmdown asks "Are you sure? [y/n]: ."

-all If  multiple servers are specif ied, automatically shuts down all of them. -q is implied with -all.

The lmdown utility must be run on a license server. You can use -all to shut down all of the license servers on your network.

If  lmdown encounters more than one server (for example if  -c specifies a directory with many *.lic files) and -all is not

specified, the utility displays a choice of license servers to shut down. You can shut down remote license servers by using -c

and specifying the name of the license server.

Note: If  you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service), stop the lmgrd
process f irst, then stop the Citrix vendor daemon process.
To stop and restart the Citrix vendor daemon only, use lmdown -c @localhost -vendor CITRIX, then use lmreread -c

@localhost -vendor CITRIX to restart the vendor daemon.

Check host names (lmhostid)

The lmhostid utility returns the host ID of the license server. You can use the command to check the host name of your

license server. You can open a license file and compare the host name in the license file to that of your license server.

Note: Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if  there are more than one
host.

Syntax

lmhostid -bindingidentifier

Argument
(bindingidentif ier)

Description

-ether Used for product licenses that are tied to the MAC address of the appliance.

-internet Used for Windows-based Citrix product software licenses that require a TCP/IP address.

-hostname Used for Windows-based Citrix product software licenses that are tied to the hostnameof
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the license server.
Note: The parameter hostname is case-sensitive and must match your license server name
exactly.

Argument
(bindingidentif ier)

Description

Reread license and options files (lmreread)

The lmreread utility causes the Citrix vendor daemon to reread changes to the license file and the options file. After

rereading, the Citrix vendor daemon uses the new settings and/or licenses going forward.

lmreread cannot be used remotely; run it locally on the license server.

Syntax

lmreread -c l icense_fi le_l ist [-al l] [-vendor CITRIX]

Argument Description

-c @localhost or -c

license_file_list

Use the specif ied license f iles.

-all If  more than one lmgrd is specif ied, instructs all License Manager daemons to
reread.

-vendor CITRIX Specif ies for the Citrix vendor daemon to be restarted.

Examples

lmreread -c @localhost [-all]

lmreread -c @client_access_point_name

lmreread -c /opt/citrix/licensing/myfiles/CITRIX.lic -vendor CITRIX

Display the list of  licensing utilit ies (lmutil)

The lmutil utility displays a list of licensing utilities when used standalone. When you specify lmutil with another command, it

executes that command.

Syntax

lmutil
lmutil  other_command

Examples

lmutil

Displays all the licensing utilities.

lmutil lmstat -c @localhost

Executes the lmstat command.

Determine licensing status (lmstat)
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The lmstat utility helps you monitor the status of all network licensing activities and provides you with information about
license check outs, including:

The product that checked out one or more licenses

The check out data

The version of the license f ile

The license server name and port

The date the license was checked out

Information about the Citrix vendor daemon status and the license f iles

lmstat displays information that it receives from the license server. lmstat displays only one use of the license, even if  there

are multiple connections sharing that license.

Syntax

lmstat [-a] [-c l icense_fi le_l ist] [-f [feature]] [-i  [feature] [-s[server] [-S [CITRIX]] [-t timeout_value]

Argument Description

-a Displays all information.

-c @localhost or -c@server or
-c license_file_list

Uses the specif ied license f iles.

-f  [feature] Displays the products using a feature (product license). If  feature is not specif ied,
usage information for all features is displayed.

-i [feature] Displays information from the INCREMENT line for the specif ied feature (product
license) or all features if  feature is not specif ied.

-s [server] Displays status of all license f iles listed on the license server or on all license servers, if
server is not specif ied.

-S [CITRIX] Lists all product servers using the features (product licenses) served by the Citrix vendor
daemon.

-t timeout_value Sets connection time-out to timeout_value. This limits the amount of time lmstat
spends attempting to connect to the license server.

The output of lmstat -c@localhost -a looks similar to:
License server status: 27000@license_server1 
License fi les on l icense_server1: C:\Program Files\Citrix\Licensing\MyFiles\citrix_startup.l ic:  
C:\Program Files\Citrix\Licensing\MyFiles\citrixl ic_20031001094430.l ic:  
 
l icense_server1: l icense server UP (MASTER) v9.2  
 
Vendor daemon status (on l icense_server1):  
 
CITRIX: UP v9.2  
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Feature usage info:  
   Users of CITRIX: (Total of 5000 l icenses issued; Total of 1 l icense in use)  
     "CITRIX" v2002.0101, vendor: CITRIX  
     floating l icense  
       MPS mps_server1 MPS MPS_ENT_2004.0227 (v1.0)  
       (l icense_server1/27000 101), start Tue 3/16 16:59  
 
   Users of MPS_ENT_CCU: (Total of 30 l icenses issued; Total of 1 l icense in use)  
     "MPS_ENT_CCU" v2004.1201, vendor: CITRIX  
     floating l icense  
     MPS mps_server1 MPS 25fb337e:MPSCLIENT  
     (v2004.0227) (l icense_server1/27000 203), start  
     Wed 3/17 11:56
The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the lmstat output:

MPS citrix_product_name The name of the Citrix product that has the license checked out.

mps_server1 hostname Computer where the Citrix product is running.

MPS display The name of the Citrix product that has the license checked out.

license_server1 server_host Computer where the license server is running.

27000 port TCP/IP port where the license server is running.

203 handle License handle. The license handle is a number used to identify a specif ic
checked out license.

start Wed 3/17
11:56

checkout_time Time that this license was f irst checked out.

Note: lmstat -c@localhost -a can potentially generate a lot of network activity in systems with many product licenses
checked out.
You can use lmstat -a to verify license check out data.

Display versions of  binaries (lmver)

The lmver utility displays version information for the licensing binaries, such as the command utilities. One exception is the

lmadmin utility. To display version information for the lmadmin utility, use lmadmin -version.

Syntax

lmver binary

Example

lmver lmdiag
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Display or release licenses for users or devices (udadmin)

udadmin displays the licensed users and devices and releases licenses for specified users and devices.

You can release a license for a user only when the employee is no longer associated with the company or is on an extended

leave of absence. You can release licenses for devices only when the devices are out of service.

Caution: Be aware that mass releases of licenses, prior to the automatic 90 day lease period, outside of the reasons
highlighted above might violate the Citrix End User License Agreement (EULA). Before doing so, contact Citrix.
The udadmin command line help displays usage information only in English, but you can use the command on non-English

systems.

Syntax

udadmin [-options] [-delete | -l ist ]  

Options Description

-f  featurename When used with -list or -delete, displays or releases the license for only the user or device for the
specif ied featurename.

-user username Releases the license for only the user specif ied by the username.

-device
devicename

Releases the license for only the device specif ied by the devicename.

-a Lists all features and versions installed on the license server.

Argument Description

-delete Releases the license for one user, feature, or device at a time.

-list Displays the users and devices with licenses and the time since the last update. The time to the next
update appears if  signif icant activity occurred within 15 minutes of the last report.

no
argument
or ?

Displays usage information for the udadmin command.

Examples

udadmin -list

Displays all the users and devices.

udadmin -list -a

Lists all features, versions, counts of licenses, and the users and devices for each feature.

udadmin -f  XDT_ENT_UD -user u8.08 -delete

Releases one user from one feature.
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udadmin -f  XDT_ENT_UD -device dn01.88 -delete

Releases one device from one feature.
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Subscription Advantage

Mar 16, 2015

When you purchase a new Citrix product, your purchase includes a one-year membership in Citrix Subscription Advantage.

This membership entitles you to, among other benefits, any product updates, including major and minor releases, released

during your membership period. For example, if  you purchased XenDesktop, Enterprise edition on July 22, 2013, you are

entitled to any updates released for XenDesktop, Enterprise edition until July 21, 2014. After your initial one-year

membership period expires, you may choose to renew your Subscription Advantage membership. After paying Citrix for your

renewal, you must go to citrix.com and download a license file containing your renewal license.

Note: A Subscription Advantage membership and its associated license are distinct from your license to run the product. If
you do not renew your Subscription Advantage membership, your Citrix products do not stop working; however, you are not
entitled to any software releases after it expires.

Adding Subscription Advantage renewal files

Subscription Advantage renewal license files contain licenses, known as renewal licenses, that extend your Subscription

Advantage membership for a one-year period. These licenses are required to run any new product releases, excluding

hotfixes, that are released during your membership period.

After you download your Subscription Advantage renewal license file from citrix.com, you must add it to your license server.

Copy the Subscription Advantage renewal license files to the same directory as your existing license files and reread the

license files. By default, this location is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server, C:\Program Files

(x86)\Citrix\Licensing\MyFiles on a 64-bit server and /opt/citrix/licensing/LS for License Server VPX. After you add the

renewal license to your license server, the license automatically unlocks any subsequent versions of the product released

during the Subscription Advantage period.

If  you do not add the Subscription Advantage renewal licenses immediately, your Citrix products do not stop working.

However, you cannot run any new software released during your renewed membership until you have the renewal license

on your license server.

You do not need to download additional licenses when you install new versions of your products during this membership

period. If  Citrix releases a product version after your Subscription Advantage membership ends, you must renew your

Subscription Advantage membership and obtain a renewal license before you can use the new product version.

Note: When you download additional license f iles, you can delete the expired Subscription Advantage licenses; however, it is
not a requirement. You might want to keep them to make it easier to identify the upgrade that is associated with each
base license.
You can f ind out what your Subscription Advantage dates are:

In the License AdministrationConsole on the Dashboard.

Using a text editor to view the license f ile: See the Upgrade Lines section in License f ile format for information about

reading the contents of the license f ile.

Renewing only part of  your Subscription Advantage membership

If  you run products from two different releases in your environment (for example, you have a mixed XenDesktop

environment of versions 5.0 and 7.0) and you are not purchasing Subscription Advantage for all your licenses, Citrix

recommends that you separate the product licenses on two separate license servers. Subscription Advantage is applied to

the older product versions first.

http://docs.citrix.com/en-us/licensing/11-13-1/lic-license-files/lic-lf-license-format-r.html
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For example, if  you own 200 licenses for 5.0 and you renew your Subscription Advantage membership for only 100 of those

licenses, it is possible that those 100 renewal licenses, which are required for 7.0, could be consumed by connections to

computers running 5.0. 

To separate your licenses (two different licenses on two different servers)

1. Select a second server and install the license server software.

2. Go to citrix.com to reallocate your original licenses (these are the licenses contained in your current license f ile on the

original license server) and then reallocate the licenses into two new files:

Allocate 5.0 licenses to create a license f ile for your f irst server

Allocate 7.0 licenses to create another license f ile for the second server

3. Generate and download your Subscription Advantage f iles and then copy them to the server to which you want them

applied.

4. Point all computers to the license server running the version of the Citrix product you want them to use. For information

about pointing your Citrix product server to the license server, see your Citrix product's administrator guide.
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Clustered license servers

Mar 16, 2015

Cluster servers are groups of computers that are combined to increase availability, reliability, and scalability. Microsoft

clustering functionality exists in:

Windows Server 2008

Windows Server 2008 R2

Windows Server 2012

Windows Server 2012 R2

Clustering the License Server lets users continue working during failure situations without interrupting their access to critical

applications. When the active node in a cluster-enabled License Server suffers from hardware failure, failover occurs

automatically. Resources are available again in a few seconds.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When the active server in a

cluster fails, the ownership of the resources in the cluster are transferred to the backup (passive) server. Typically, users

cannot detect when one server in a cluster fails over to another.

When the active node of a clustered License Server fails, there is no impact on users connected to the Citrix product. The

product may briefly enter the licensing grace period and an event may be written in the product's event log.

Important
License Server VPX does not support clustered License Servers. You can use the High Availability (HA) feature on XenServer 5.6 and

later.

Citrix Licensing in a cluster

Like most clusters, a private network is used to send heartbeats, commands, and state information between the nodes of

the cluster. If  the connection is interrupted, the nodes try to reconnect by the private network first, then the public

network. The following diagram illustrates a cluster-enabled licensing deployment:

Figure 1. Communications in a clustered licensing environment
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Only one node can use the resources in a cluster at any given time. If  you already deployed Citrix Licensing and you want to
migrate your deployment to a cluster-enabled server, keep the following points in mind:

Because you already generated license f iles that reference a specif ic server name, you must either give the client access

point the same name as the original License Server or rehost your license f iles with the new name of the License Server

cluster.

Host names in license f iles are case-sensitive; therefore, the client access point names must be the same case as the

host names in the license f ile. If  they are not, you must rehost your license f iles with the correct capitalization of the

names. You can use the Failover Cluster Manager to ensure the client access point name matches the host name

specif ied in the license f ile. Note: Cluster and host name case is not an issue if  you use Studio in XenDesktop or the

Simple License Service (from the Start menu on your License Server) to download your licenses.

You must point all product installations (for example, servers running Citrix XenDesktop) serviced by the old License Server

to the new License Server cluster. Change product communication settings so that they use the name of the client

access point as the License Server name. For information about editing product-side communication settings, see the

product's documentation.

Opening the console or running commands

All licensing administration features available in standard deployments are also available on clustered License Servers,

including the management console and the ability to run license administration commands.

Open the License Administration Console in a cluster by browsing to:

https://cl ient access point name:web service port
Where client access point name is the name of the cluster and web service port is the port number for console

communications (the default port number is 8082).

You can run many license administration commands using the argument -c @client access point name to specify the
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location of the license file(s) in the cluster. For example:

lmreread -c @client access point name
Requirements for clustered License Servers

The following list outlines the requirements for setting up a License Server in a Microsoft Cluster:
Citrix Licensing does not support Clustered Shared Volumes or third party Volume Management products for clusters.

Before configuring Citrix Licensing for Microsoft clustering, you must have a fully-functional Microsoft cluster

environment. Citrix Licensing Services runs on only one node at a time.

To cluster the License Server, you must follow the following cluster requirements in addition to any requirements from

Microsoft for hardware and clustering in general.

You must install licensing on the cluster with the License Server installer CitrixLicensing.exe.

When you install Citrix Licensing on a cluster, you must specify the name of the client access point when prompted for

the name of the License Server during product installation.

Citrix recommends that you use identical License Server hardware for each node in the cluster. In particular, Citrix

recommends two network adapters on each node and the servers have one drive configured as a shared drive.

Each node should have two network adapters-one for connection to the public network and the other for the node-to-

node private cluster network. Citrix does not support using one network adapter for both connections.

The public and the private IP address must be on different subnets because the Cluster Service will recognize only one

network interface per subnet.

A name resolution method, such as DNS, WINS, HOSTS, or LMHOSTS, is necessary to resolve the client access point

name.

Each server that form the cluster must be in the same domain.

Set static IP addresses for the private network connector.

When you generate a license f ile at citrix.com, use the name of the client access point when prompted for the host

name.

After you download a license f ile, you must copy it to the F:\Program Files\Citrix\Licensing\MyFiles folder (where F: is the

shared drive for the cluster) on the License Server and reread it. Alternatively, use the License Administration Console to

download, copy, and reread the f ile.

Important
Citrix recommends setting static IP addresses for all network adapters in the cluster, both private and public. If IP addresses are

obtained by Dynamic Host Configuration Protocol (DHCP), access to cluster nodes could become unavailable if the DHCP server

goes down. If you must use DHCP for your public network adapter, use long lease periods to assure that the dynamically assigned

lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reservation.

Overview of  the clustering process

The following steps describe the overall process involved in installing and configuring licensing on a cluster-enabled server.
These steps assume you configured the clustering on the hardware on which you intend to install the License Server.
1. Create a cluster resource group. Assign a client access point and shared storage to the resource group. Ensure that the

first node has control of the cluster resources and the resource group you created points to the f irst node.

2. On the f irst node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an administrator and install it on

the f irst node to the shared cluster drive (not the quorum drive). Leave the Last Node in Cluster checkbox unchecked.

3. Move the resources from the active node in the cluster to the second node.

4. Install the License Server on the second node to the same shared location as the f irst node. Note that you can add
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more than two nodes to a cluster.

5. When installing the License Server on the last node in the cluster, ensure that you check the Last Node in Cluster

checkbox.

6. Obtain license f iles that specify the client access point name of the License Server as the host name. After obtaining

license f iles, you must add them to the License Server and then reread them.

7. Configure your Citrix product to use the client access point name-not the node name-of the License Server cluster.

Important
When a clustered License Server fails over, the cluster service renames the lmgrd_debug.log to the name of the node that

previously hosted the services. Then it starts the services on the new active node and creates a new lmgrd_debug.log.
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Install, upgrade, and uninstall

Jan 09, 2015

Install licensing on a clustered-enabled server

The following drive letters and paths/variables are used in this procedure:

D is the drive for your product media.

C is the local hard drive on the specif ied node.

F is the cluster shared drive resource. (This is the installation drive. That is, the place where installation f iles used by each

node are stored.)

1. You must create a separate, noncore cluster resource group. The resource group must have attached storage assigned a

drive letter and a client access point with the same hostname name used when obtaining the license f ile. Create this by

using the failover cluster manager and going to Services and applications in Windows 2008 or Roles in Windows 2012 and

select the Other Server type in the menu. Ensure all cluster resources are owned by the f irst node of the cluster.

2. Run the License Server installer, CitrixLicensing.exe, as an administrator.

3. On the Install Location page, set the drive letter to correspond with the cluster shared drive. By default, the licensing

components are installed in F:\Program Files\Citrix\Licensing.

4. Leave the Last Node in Cluster checkbox unchecked during the installation on the f irst node.

5. Move the resources for the resource group you created in Step 1 to the second node.

6. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.

7. Go back to Step 3. You can install more than two nodes on the cluster. You can install more than two nodes on the

cluster. For each additional cluster, repeat Step 3.

8. When installing the License Server on the last node in the cluster, ensure that the Last node in the cluster check box is

checked. The last node is where the ports are configured.

9. Import your license f iles using the console.

1. Open the License Administration Console from http://client access point name:web service port, where client access

point name is the name of the cluster and web service port is the port number for the console Web server (8082 by

default).

2. Click Administration and choose the Vendor Daemon Configuration tab.

3. Click Import License.

4. Click the citrix.com link.

5. On the My Account page, enter your user ID and password.

6. Select All Licensing Tools.

7. From the main menu, select Allocate.

8. Follow the process to allocate and generate your f ile. Select the licenses you want to download, click Download and

save generated license f iles to the shared drive of the cluster: F:\Program Files\Citrix\Licensing\MyFiles\.

9. In the License Administration Console on the Import License File page, browse to the license f ile.

10. Select Overwrite License File on License Server.

11. Click Import License.

10. Reread the license f iles.

1. Choose the Vendor Daemon Configuration tab.

2. Click Administer in the CITRIX vendor daemon line.

3. Click Reread License Files.

Upgrade a clustered License Server
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If  you are running a version of a License Server older than 11.12.1, uninstall it and then install this version. The older versions

of the License Server do not conform to current Microsoft cluster guidelines.This version of the License Server has the

functionality required to work with Windows Server 2008 and greater.

Uninstall a clustered License Server

Uninstall licensing from a clustered License Server using the Control Panel > Programs and Features option from the active
node.
1. From the f irst node in the cluster, launch Control Panel > Programs and Features .

2. Remove Citrix Licensing.

3. Using the failover cluster manager, move the resources in the Citrix Licensing resource group to the second node.

4. Remove Citrix Licensing from the second node. If  there are additional nodes, repeat Steps 3 and 4 for each node, and

then procede to Step 5.

5. Delete the remaining f iles from the shared drive.

Note: The uninstallation process does not remove the license f iles and options f ile from the shared drive.
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Troubleshoot cluster-enabled license servers

Apr 19, 2013

Note: If  any of the licensing services fail to start, the cluster detects that licensing is off line and attempts to restart the
service three times (by default). If  these attempts are unsuccessful, fail-over to the next node is initiated and the cluster
attempts to start the services on the second node. If  the attempts fail on the second server, the process may enter into an
infinite loop. In this case, the computers running Citrix products fall into the grace period. During the grace period, client
connections are not affected.
When troubleshooting a cluster-enabled license server, try the following:

If  you move the resources to the other node, do you still see the issue?

Did you check the Use Network Name for Computer Name check box in the Microsoft Cluster Server? See

http://support.microsoft.com/kb/198893.

For Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012:

1. In the Failover Cluster Management window, from the left pane, select the cluster. In the middle pane, the summary

information for the cluster appears.

2. Click the Cluster Core Resources title to expand the section.

3. Verify that the cluster resources are all online (green arrow).

http://support.microsoft.com/kb/198893
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Back up

Mar 16, 2015

Depending on how crucial the applications associated with your licenses are, you may want to create backup License

Servers. Although Citrix stores backup copies of your licenses, downloading many replacement licenses can be time-

consuming. You can either store backup licenses on a network file share or have a configured backup License Server ready in

case of License Server failure.

Redundancy solutions

Setting up redundancy solutions might be necessary only in mission-critical environments. For smaller or less mission-critical

deployments, you can back up your License Server by creating a duplicate License Server that can be stored on or off  the

network.

You can ensure redundancy for your mission-critical environments by:
Creating a clustered License Server. For more information about clustering and licensing, see Setting up the License

Server on a Microsoft Cluster.

Using the High Availability (HA) feature on XenServer 5.6 and later.

Duplicating the License Server and its contents - Give the duplicate computer the same name as the active License

Server and store it off  the network.

Storing an additional License Server on the network with a different server name - In this case, when the active License

Server fails, you need to change the backup server name to start using it as the active License Server.

Using a network applicance - If  you are using only one License Server to service license requests at any time, you can use

a network appliance that detects server or network outages and route traff ic to a backup License Server.

All methods let you exchange one server license for another without a loss of service, provided the exchange occurs within
the grace period. There are key points to remember:

Because license f iles reference the server specif ied during allocation, you can use the f iles only on a server with the same

binding information (server name or FQDN or MAC address (possibly displayed on the portal as Ethernet address) as the

original License Server

You cannot have two License Servers with the same name on your network active at the same time

You must add any additional licenses that you download to both the active License Server and the backup License Server

http://docs.citrix.com/en-us/licensing/11-13-1/lic-cl-citrix-environment-c.html
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Frequently Asked Questions for Licensing

Mar 16, 2015

These are frequently asked questions about your licensing environment.

Can I rename the license server?

License files run only on the license server for which they were made. More specifically, license files contain the hostname or

binding identifier of the license server you specify when you allocate the licenses. You cannot use the license file that you

generated, which specifies a particular license server name, or a MAC address (in the case of an appliance.), with a different

license server name or appliance.

Create new license files that reference the new server name or MAC address by reallocating and generating the new file.

If  I upgrade my license server will it  affect my license files?

No. The license server and all product licenses are fully backward compatible and will not introduce any issues into your

environment.

Can a single license server supply licenses to users connecting from different servers using different
product editions?

Yes. One license server can contain licenses for multiple editions of a Citrix product. The type of license checked out

corresponds to the edition that is configured on the product server. A product server is configured to consume an edition of

a license and therefore will check out that edition of a license.

For example:

ProductServerA is configured to checkout Enterprise licenses.

ProductServerB is configured to checkout Platinum licenses.

LicenseServer1 contains both Enterprise and Platinum licenses.

Users who connect to LicenseServer1 from ProductServerA will check out Enterprise licenses only. Once the number of

Enterprise licenses on LicenseServer1 is exceeded, new requests from ProductServerA users will be denied until existing

Enterprise connection licenses are released.

Users who connect to LicenseServer1 from ProductServerB will check out Platinum licenses only. Once again, if  the

number of Platinum licenses on LicenseServer1 is exceeded, new requests from ProductServerB users will be denied until

Platinum connection licenses are released.

Note: License checkout times may increase if  many product servers with many users are contacting the same license server
simultaneously. One license server can accept only 10,000 inbound TCP-IP requests at one time. If  you are planning to have
more than 10,000 computers connecting at the same time, Citrix recommends that you use several license servers.
Examples of Possible Deployments:

Scenario 1: Two farms

FarmA contains product servers configured for Enterprise edition

FarmB contains product servers configured for Platinum edition

One license server (shared)
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User1, User2, User3, User4...User5000 connect only to FarmA

User5001, User5002, User5003...User10000 connect only to FarmB

Scenario 2: One farm

The farm has two sets of published applications

One set of applications is hosted by product servers configured for Enterprise edition

One set of applications is hosted by product servers configured for Platinum edition

One license server (shared)

User1, User2, User3, User4...User5000 connect only to product servers with the f irst set of applications

User5001, User5002, User5003...User10000 connect only to product servers with the second set of applications
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